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1. Workflows

Workflows 21.0 W1 (Workflows Update 1)

The Oasys Suite contains powerful tools and capabilities that can be used to interrogate

and debug your analysis results. However...

1. The basic tools are not always customised for your specific loadcases or tasks

2. You may need to manually perform a number of steps to process your results,

which can be time-consuming and prone to error

3. The JavaScript API can be used to create tools to automate your post-processing

workflow, but this requires time, resource and knowledge, which is not always

available

To address these issues, the Workflows feature provides tools customised for specific

loadcases and tasks, built upon the existing capabilities in the Oasys Suite, to make it easier

to interrogate and post-process results.

In addition to the tools provided (described in the following topics) you can create your

own bespoke tools. Please contact us if you have an idea for a tool and would like some

help creating it.

Releases

The Workflows tools are constantly being improved and enhanced. If you have any

requests for new features or experience issues using Workflows, please contact us and we

will aim to address your requests in future releases. This documentation is for 21.0 W1

(Workflows Update 1). A record of all releases is listed below.

Workflows Releases

Dat

e

Releas

e
Description

Documentatio

n

Minimu

m

required

Oasys

Suite

version

Downloa

d

Changelo

g

21.0 W1

21.0 Workflows

Update 1 –

Comprehensiv

e support for

21.0

https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
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Workflows Releases

Euro NCAP

Virtual Far Side

Protocol v1.0

15-

May-

2024

21.0

First version

containing

Virtual Testing

tools

21.0
Oasys

Suite

download

Oasys 21.0

Release

Notes

08-

Nov-

2023

20.1 Bug fix release
Workflow Tools 

20.1
20.1

No longer

available

Oasys 20.1

Release

Notes

17-

Apr-

2023

20.0
First release of

Workflows

Workflow Tools 

20.0
20.0

No longer

available

Oasys 20.0

Release

Notes

https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2024/05/oasys21_Release_Notes_with_cover.pdf
https://help.oasys-software.com/articles/primer-20-1/workflow-tools
https://help.oasys-software.com/articles/primer-20-1/workflow-tools
https://help.oasys-software.com/articles/primer-20-1/workflow-tools
https://help.oasys-software.com/articles/primer-20-1/workflow-tools
https://help.oasys-software.com/articles/primer-20-1/workflow-tools
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/11/oasys201_Release_Notes-1.pdf
https://help.oasys-software.com/articles/primer-20-0/workflow-tools
https://help.oasys-software.com/articles/primer-20-0/workflow-tools
https://help.oasys-software.com/articles/primer-20-0/workflow-tools
https://help.oasys-software.com/articles/primer-20-0/workflow-tools
https://help.oasys-software.com/articles/primer-20-0/workflow-tools
https://www.oasys-software.com/dyna/downloads/oasys-suite/
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
https://www.oasys-software.com/dyna/wp-content/uploads/2023/04/oasys20_Release_Notes.pdf
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2. Workflow User Data

Saving user data

Workflows enable you to tag your models in PRIMER with user data which can be utilised in

D3PLOT, T/HIS, and REPORTER to provide relevant post-processing analysis tools.

The user data can either be saved in a JSON file or as post *END data in the model keyword file.

In PRIMER, each Workflow Tool will have buttons in the main window for saving either to a file

or to a model, e.g. for the Automotive Assessments workflow:

User data saved to JSON files

If the data is saved to a JSON file, the file either needs to be saved in the same directory as the

model or in a parent directory for it to be found when loading model results in D3PLOT, T/HIS

and REPORTER.

The name of the file can be anything you want, although it must have the .json extension.

Saving JSON files in parent directories means that you only have to setup the user data once and it
can be used by multiple models. 

For example, in the folder structure below, the parent_user_data.json file in dir_1 will be used

for the results in dir_3 and dir_4 and the user_data.json file in dir_2 will be used for the model

in dir_2:
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- dir_1

     |- parent_user_data.json

     |

     |- dir_2

     |       |- model1.key

     |       |- d3thdt

     |       |- d3plot

     |       |- user_data.json

     |

     |- dir_3

     |       |- model2.key

     |       |- d3thdt

     |       |- d3plot

     |       

     |- dir_4

     |       |- model3.key

     |       |- d3thdt

     |       |- d3plot

Maximum number of directories to search up

The maximum number of directories up from a model/results directory that will be searched is

set to 4 by default, but it can be changed by setting the

preference oasys*workflow_max_upward_folder_search_depth.

For example, in the following folder structure, the grandparent_user_data.json file is 2

directories up from the model in dir_3 and will be found when reading the results into D3PLOT,

T/HIS and REPORTER.

- dir_1

     |- grandparent_user_data.json

     |

     |- dir_2

     |       |- dir_3

     |              |- model1.key

     |              |- d3thdt

     |              |- d3plot

Search in workflow_user_data directory

The search for user data JSON files will also look in a folder named workflow_user_data in the

model folder and its parent folders.

For example in the below folder structure, the parent_user_data.json file in

dir_1/workflow_user_data will be used for the models in dir_3 and dir_4, and the user_data.json

file in dir_2 will be used for the model in dir_2:
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- dir_1

     |- workflow_user_data

     |       |- parent_user_data.json

     |

     |- dir_2

     |       |- model1.key

     |       |- user_data.json

     |

     |- dir_3

     |       |- model2.key

     |       

     |- dir_4

     |       |- model3.key

The name of the directory to search can be changed by setting the

preference oasys*workflow_user_data_directory_name. This allows you to store your user

data files in a helpfully named directory in your LS-DYNA analysis area. 

Writing user data for multiple Workflows 

When writing user data for multiple Workflows, you have two options:

1. Write the user data for each Workflow to a separate JSON file:

- dir_1

     |- model1.key

     |- d3thdt

     |- d3plot

     |- user_data_workflow_1.json

     |- user_data_workflow_2.json

     |- user_data_workflow_3.json

2. Write the user data for each Workflow to a single JSON file:

- dir_1

     |- model1.key

     |- d3thdt

     |- d3plot

     |- user_data.json   ← Contains user data for Workflows 1, 2 and 3

The option you chose will depend on how you want to organise your files, but in terms of

how the data is read in D3PLOT, T/HIS and REPORTER, there is no difference.

To write multiple Workflows,  you need to select an existing user data JSON file when saving

the file.
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· If user data for the workflow already exists in the file it will overwrite that data, but

preserve the user data for any other workflows that already exist in the file.

· If user data for the workflow doesn't exist in the file it will append it to the existing

user data for any other workflows in the file.

User data saved in keyword files

If the data is saved to a model it is stored as post *END data in the master keyword file,

e.g.:

$
*END
*PRIMER_USER_DATA
WORKFLOW_START
{"workflows":[{"program":"PRIMER","major_version":21,"minor_version":0,"build
_ +
number":34854,"workflow_definition":{"filename":"$OA_WORKFLOW\\automotive_ass
e +
ssments.json"},"data":{"user_data_version":"21.0","regulations":["EuroNCAP"],
" +
crash_test":"FFB","version":"2017","drive_side":"LHD","occupants":[],"structu
r +
es":[],"b_pillar":null,"head_excursion":null,"head_intrusion":null},"model_un
i +
t_system":"U2"}]}
WORKFLOW_END

When you click Save To Model in the Workflow window, it is important to note that this

adds the data to the model, but it doesn't automatically write the model to disk. You need

to manually use Model→Write to save the data to the keyword file.
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3. Workflow Tools

Workflow Tools

The Workflow Tools currently available are listed below (or use the topics navigator on the

left). Please contact us if you have an idea for a tool and would like some help creating it.

Automotive Assessments

Process crash and occupant safety simulations according

to legal regulations and consumer safety NCAP protocols

Energy Check

Plot total, kinetic, internal and hourglass energy, and

perform various checks to highlight possible issues

Entities of Interest

Perform actions on predefined groups of parts

Eroded Elements

Visualise deleted elements at different states

https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
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Intrusion Contour Plot

Produce a front intrusion contour plot (e.g. for vehicle 

cockpit intrusion) for selected parts

Pulse Index Tool

Perform a vehicle pulse index calculation for a virtual 

occupant

Storey Drift

Extract storey drift data from a seismic response time 

history analysis

Storey Force

Extract storey force data from a seismic response time 

history analysis

Strength Check

Identify and visualise yielding parts

Virtual Testing
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Euro NCAP VTC Quality Criteria

Quality Criteria check according to Section 6.1 of the 

Euro NCAP Virtual Far Side Simulation & Assessment 

Protocol

Euro NCAP VTC Videos

Create the videos specified in Section 5.2.1 of the Euro 

NCAP Virtual Far Side Simulation & Assessment Protocol

LS-DYNA to ISO-MME

Automatically export ISO-MME channels from LS-DYNA 

results

SimVT

Compare simulation versus test curves, or indeed any 

combination of: LS-DYNA models, ISO-MME data and CSV 

data.

Supports the ISO/TS 18571 rating method.



Page 11 of 235

3.1. Automotive Assessments

Automotive Assessments

Tools→Workflows→ Automotive Assessments

The Automotive Assessments workflow tool is used to post-process analyses

according to various crash test regulations.

In PRIMER you select the crash test type and the occupants and structures to be assessed.
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In D3PLOT, T/HIS and REPORTER this data is used to carry out assessments according to

the crash test type and regulation.
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3.1.1. Automotive Assessments PRIMER

When Automotive Assessments is launched in PRIMER you are presented with this window.

This is where you specify the crash test type and the occupants and structures you want to

assess:

You first specify the crash test type of your model from the dropdown menu:

This will update the Regulation dropdown menu with regulations that are supported by the

tool for the selected crash test type. Select the regulation you want to assess your model

with:
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The Version dropdown menu will get updated with versions that are supported by the tool

for the selected crash test type and regulation. Select the version you want to assess your

model with:

Then select the unit system of your model:

Occupants

The Occupants section is used to select which occupants are in the vehicle, their positions

in the vehicle and the IDs of the entities from which data can be read from.  This section

updates automatically to show the required occupants for the selected crash test type and

regulation. In the image below it shows that two HIII-50M occupants are expected in the

driver and front passenger positions.
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The first thing to do is select whether the vehicle is left hand or right hand drive (LHD or

RHD). The vehicle image will update to show the steering wheel on the correct side and the

occupant positions will also update:

For each occupant, click Add.  Note that if your model does not have an occupant (or you

don't want to carry out an assessment on it) you can leave it empty. T/HIS and D3PLOT will

only attempt to process results for occupants that have been added.
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Clicking Add opens a window where you can set the occupant type and select the IDs of

entities:
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The occupant type can be selected from the Occupant Name dropdown menu.

The options shown in this dropdown are filtered by the values in the Supplier, Product

and Physiology dropdown menus. When the window is first opened these are

automatically set so only occupant types that are relevant for the selected crash test type,

regulation and occupant position are shown.

In this example the selected occupant is expected to be a HIII-50M occupant so the Product

filter is set to HIII and the Physiology filter is set to 50M.

If for some reason you wish to select an occupant of a different type to the one expected,

you can change the values of the filters to list other occupant types.

The position of the occupant in the vehicle will be set automatically, but you can change

this with the Position dropdown menu if required:
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Entity IDs can be specified either by their numerical labels or DATABASE_HISTORY titles (for

entities that have them defined) or DATABASE_CROSS_SECTION titles for X-Sections.

The tool knows what the default numerical labels are for each entity in each occupant type

and will automatically fill the textboxes in with those values. If they do not exist in the

model, for example if the model has been renumbered, the textboxes are coloured red,

e.g.

If they do exist the textboxes will change colour to indicate that (the colour will depend on

the UI Theme), e.g.

If the occupant has been renumbered so the labels are offset from the default ones, the

Offset for IDs option can be used to apply the offset. This is useful when you have two or

more occupants of the same type in the model as they both can't have the same entity

labels.

Offset = 0:
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Offset = 10000:

Alternatively, the entity IDs can be specified using DATABASE_HISTORY and

DATABASE_CROSS_SECTION titles instead of their numerical labels. To automatically switch

to use titles where they exist you can click on the Use Database History Titles button:

Note that a mix of defining some entities using numerical labels and others with titles is

perfectly valid, they don't all have to be defined the same way.

You can manually select entities by right clicking on a textbox. This opens a popup window

which allows you to Pick or Select the entity interactively on the screen or select it from a

list of DATABASE_HISTORY / DATABASE_CROSS_SECTION entities (ones with titles are listed

first and ones without at the bottom).
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Once the entities have been defined you can press Add at the top of the window to add the

occupant definition.

This will close the window and the Occupants section will update to show that an occupant

has been defined in the selected position. If all the entity IDs are defined and valid the

occupant will be shown like this:
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If there are any undefined or invalid entity IDs it will look like this, i.e. enclosed in angular

brackets "< >":

If the occupant is a different type to the one expected it will look like this:

T/HIS and D3PLOT will cope with any undefined or invalid, but obviously won't be able to

carry out any assessments that require them.

If you want to edit or delete the occupant, you can click on the Edit or Delete buttons.

Supported Dummies 

The following table lists all the occupants supported in the Automotive Assessment

Workflows, along with the corresponding supplier documentation filename that was

referenced in creating the respective occupant JSON files.

Suppli

er

Pro

duc

t

Physi

ology

Versi

on
JSON Manual



Page 24 of 235

Suppli

er

Pro

duc

t

Physi

ology

Versi

on
JSON Manual

PDB
WSI

D
50M

v4.0

LHD

PDB

WSID

50M

v4.0

LHD

wsid50_pdb_v4.0_manual_v0.0.pdf

PDB
WSI

D
50M

v4.0

RHD

PDB

WSID

50M

v4.0

RHD

wsid50_pdb_v4.0_manual_v0.0.pdf

PDB
WSI

D
50M

v6.0

LHD

PDB

WSID

50M

v6.0

LHD

wsid50_pdb_v6.0_manual_v0.0.pdf

PDB
WSI

D
50M

v6.0

RHD

PDB

WSID

50M

v6.0

RHD

wsid50_pdb_v6.0_manual_v0.0.pdf

PDB
WSI

D
50M

v7.6

LHD

PDB

WSID

50M

v7.6

LHD

wsid50_pdb_v7.6.1_manual_v0.pdf

PDB
WSI

D
50M

v7.6

RHD

PDB

WSID

50M

v7.6

RHD

wsid50_pdb_v7.6.1_manual_v0.pdf

PDB
WSI

D
50M

v8.0

LHD

PDB

WSID

50M

v8.0

LHD

wsid50_pdb_v8.0_manual.pdf

PDB WSI 50M v8.0 PDB wsid50_pdb_v8.0_manual.pdf
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Suppli

er

Pro

duc

t

Physi

ology

Versi

on
JSON Manual

D RHD WSID

50M

v8.0

RHD

PDB
WSI

D
50M

v8.1

LHD

PDB

WSID

50M

v8.1

LHD

wsid50_pdb_v8.1_manual.pdf

PDB
WSI

D
50M

v8.1

RHD

PDB

WSID

50M

v8.1

RHD

wsid50_pdb_v8.1_manual.pdf

DYNA

MORE

ES-

2re
50M v6.0

DYNA

MORE

ES-2re

50M

v6.0

es2_v_6.0_users_manual_v0.0.pdf

LSTC

SID

2-

SB

DL

5F

v.0.15

0.bet

a

LSTC

SID2-

SBDL

5F

v.0.150

.beta

Documentation_for_LSTC_SID-IIs-

D_Version_0.150.beta.pdf

LSTC HIII 50M

Detail

ed

19021

7

Beta

LSTC

HIII

50M

Detaile

d

19021

7 Beta

LSTC.H3_50TH.130528_BETA.pdf

LSTC HIII 50M
Fast

2.0

LSTC

HIII

50M

Fast

LSTC.H3_50TH_FAST.111130_V2.0_Documentation.pdf
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Suppli

er

Pro

duc

t

Physi

ology

Versi

on
JSON Manual

2.0

LSTC HIII 5F
Fast

2.0

LSTC

HIII 5F

Fast

2.0

LSTC.H3_5TH_FAST.111130_V2.0_Documentation.pdf

LSTC HIII 5F v2

LSTC

HIII 5F

v2

LSTC.H3_05TH_DETAILED.160920_V2.0.pdf

LSTC HIII 5F v2.1

LSTC

HIII 5F

v2.1

LSTC.H3_05TH_DETAILED.160920_V2.0.pdf

HUMA

NETICS

SID

2-

SB

DL

5F
v.4.3.

2

HUMA

NETICS

SID2-

SBDL

5F

v.4.3.2

Humanetics_SID2s_SBLD_V4.3.2_LS-

DYNA_UserManual_TechnicalReport.pdf

HUMA

NETICS

SID

2-

SB

DL

5F
v.4.3.

5

HUMA

NETICS

SID2-

SBDL

5F

v.4.3.5

Humanetics_SID2s_SBLD_V4.3.5_LS-

DYNA_UserManual_TechnicalReport.pdf

HUMA

NETICS

TH

OR
50M v1.9

HUMA

NETICS

THOR

50M

v1.9

HUMANETICS_THOR_50M_USNCAP_V1.9_LS_DYNA_TECH

NICAL_REPORT_USERS_MANUAL.pdf

HUMA

NETICS

TH

OR
50M v1.8

HUMA

NETICS

THOR

50M

v1.8

HUMANETICS_THOR_50M_EuroNCAP_V1.8_LS_DYNA_TEC

HNICAL_REPORT_USERS_MANUAL.pdf

HUMA

NETICS
HIII 50M v.1.5

HUMA

NETICS

HUMANETICS_HIII_50M_V1.5.1_HARMONIZED_LS_DYNA_

TECHNICAL_REPORT_USER_MANUAL.pdf
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Structures

The Structures section is used to select the IDs of the entities from which data can be read

from structures in the vehicle.  This section updates automatically to show the required

structures for the selected crash test type and regulation. In the image below it shows that

an A-Pillar, Accelerator Pedal, Brake Pedal, Clutch Pedal and Steering Column structures are

to be assessed.
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Click on one of the structures to open a window where you can select the entity IDs. 

This works in the same way as the occupants window where IDs can be specified either by

their numerical labels or DATABASE_HISTORY titles (for entities that have them defined).

If they do not exist in the model, the textboxes are coloured red. If they do exist they

change colour (the colour will depend on the UI Theme), e.g.

To select entity IDs for other structures you can use the Structure dropdown menu:
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Note that if your model does not have a structure (or you don't want to carry out an

assessment on it) you can leave it empty. T/HIS and D3PLOT will only attempt to process

results for structures that have been added.

Once you have selected all the entity IDs click on Update All to save them and close the

window.  

The Remove button sets all the entity IDs of the current structure to 0, effectively removing

it from the assessment.

The Reset button sets the entity IDs back to what they were before any edits were made.

The Cancel button closes the window, without saving the selected entity IDs.

After you have selected entity IDs the structures section will update with different colours

to show what is defined and what is not, e.g

Structures that are coloured like this mean they have all the required entity IDs defined and

the exist in the model:

Structures that are coloured like this and enclosed in < >'s mean some of the required

entity IDs are defined and exist in the model, but there are others that are either undefined

or don't exist in the model:
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Structures coloured like this and enclosed in < >'s mean none of the required entity IDs are

defined or exist in the model:

Saving

Users can choose to save the data to a .JSON file or directly to the model. The user data

from the file will then be picked up when the workflow is selected in T/HIS or D3PLOT. Note

if you choose to save the data to the model then you will need to save the model in PRIMER

to ensure that the data is written to the master keyword file.
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3.1.2. Automotive Assessments T/HIS

When the tool is launched in T/HIS you are presented with this window. This is where you

select what assessments you want to carry out.

The dropdown menus on the left hand side show the regulation being used to carry out the

assessments and the version. The model unit system is also shown.

To select what assessments to carry out, you first need to select which occupant(s) you

want to assess.

To select a single occupant, left-click on the one you want to assess.  Use shift and left-click

or ctrl and left-click to select multiple occupants. If you want to select all the occupants you

can press the tick button and to deselect them all press the cross.
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You can then select the body part(s) you want to assess.

This will populate the Occupant Assessment Types list with the assessments that can be

carried out for the selected body parts and occupants. By default they will all be selected,

but you can chose to select only a subset of the list if you don't want to do them all.

You can also select which structure(s) which you want to assess

This will populate the Structure Assessment Types list with the assessments that can be

carried out for the selected structures.
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You can then chose how the graphs for each assessment should be displayed. By default

they will all be put on one page and overwrite any existing graphs, but you can also chose

to put each one on a separate page and append them to existing graphs.

Once you are happy with your choices, click Plot to carry out the assessments. T/HIS will

extract the data required for each assessment, process it according to the rules set out in

the regulation and plot the results on a graph with datums showing allowable limits (where

they are defined by the regulation), e.g. the CHEST_COMPRESSION assessment for the

driver:

If you have selected multiple occupants the curves for each occupant will be plotted on the

same graph if the datum values are the same. If the datum values are different they will be

plotted on separate graphs.
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The output box at the bottom of the window lists the values and scores from the

assessments carried out. Clicking on the '->' for each assessment will highlight the curve

used for the assessment (and select the page if it's not on the current page) to make it easy

to locate:

Multiple Models

It is also possible to plot results from multiple models on the same graphs. This is useful

when you want to compare results between different runs.

First you'll need to load the results from the models you want to compare into T/HIS and

then on the workflow menu, select Multiple Models, pick the models you want to compare

and press Run. Note that the models need to be of the same crash test type and

regulation. If they're not the tool will refuse to run.
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The window will then be populated with the occupants and structures from all the selected

models, pre-pending them with the model number (M1, M2, etc)

If you wanted to compare the results for a CHEST_COMPRESSION assessment of the driver

you would select the occupants in both models, select the chest body part and the

CHEST_COMPRESSION assessment type.
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Euro NCAP Virtual Far Side Protocol Validation

Criterion 2

Automotive Assessments can be used to check Validation Criterion 2, according to Section

6.3 of the Euro NCAP Virtual Far Side Simulation & Assessment Protocol. The Assessment

Criteria ratios and differences are calculated and presented in the output table.

If you selected the Far Side + VTC crash test in PRIMER, then when you open Automotive

Assessments in T/HIS, you will be presented with the window below. Here, you can import

and select a test model and choose the assessments you want to carry out.

You can import a test model using the Import ISO-MME/CSV… button. Once imported, you

can choose which model to use as a test model from the Select a test model combo box. 

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf


Page 37 of 235

The output table at the bottom of the window lists the injury values, Validation Criteria 2

ratios and differences (\(r_{AC_{sim}}\), \(r_{AC_{test}}\) and \(d_{AC}\) from Equation 4 of

the Euro NCAP VTC protocol) and scores for the assessments carried out.

The following example below explains how \(r_{AC_{sim}}\), \(r_{AC_{test}}\) and \(d_{AC}\)

are represented in the output table.

If you select simulation (M1) Driver and test data (T1) Driver in the Occupants selection and

click Plot, assessments will be carried out for both M1 and T1, with T1 used as the test

model (reference) for both.

· According to equation 4, the \(r_{AC_{sim}}\) value is calculated as \(r_{AC_{sim}} =

\frac{AC_{sim}}{AC_{limit}}\), for all occupants selected, except for those where the

assessment model is the same as the selected test model. In this example, it is only

calculated for M1. Appropriate hover text is available for cells where \(r_{AC_{sim}}\)

was not calculated, and 'N/A' is displayed for such cells.
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· According to equation 4, the \(r_{AC_{test}}\) value is calculated as \(r_{AC_{test}} =

\frac{AC_{test}}{AC_{limit}}\), for all occupants. The model selected in the Select test

model combo box will be used as the test model. The \(r_{AC_{test}}\) cells will have

hover text displaying the Assessment Criteria Limit value for that particular

assessment, as specified in Table 7 of the Euro NCAP VTC protocol.

· According to equation 5, the \(d_{AC}\) value is calculated as \(d_{AC} = \left|

r_{AC\text{ test}} - r_{AC\text{ sim}} \right| \). The \(d_{AC}\) values will only be

calculated if the \(r_{AC_{sim}}\) is calculated and \(r_{AC\text{ test}} \geq 50\%\). If

calculated, appropriate hover text will be added to the cell, and the cell will be

colour-coded to indicate if that assessment meets Validation Criterion 2. 

          The deviations between the ratios must be < 30% for each considered assessment

criteria to fulfill the validation criterion 2. 

          \(\text{Validation Criterion 2 (Assessment Criteria): } d_{AC} < 30\%\)
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3.1.3. Automotive Assessments D3PLOT

Some structural assessments involve more than just plotting curves on graphs – for

example, taking cut sections through the model to measure intrusion. These assessments

are carried out in D3PLOT.

When the tool is launched in D3PLOT you are presented with this window. This is where

you select what assessments you want to carry out.

Select the structure you want to assess

This will populate the Structure Assessment Types list with the assessments that can be

carried out for the selected structures.
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Click Run to carry out the assessment. D3PLOT will extract the data required for the

assessment and process it according to the rules set out in the regulation. Depending on

the assessment, this may involve starting other programs like PRIMER or REPORTER to

carry out parts of the assessment.

It will eventually produce an image which it will display in the window and a list of output

values in the Output window:
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3.1.4. Automotive Assessments REPORTER

Standard Templates

The following standard library templates have been updated so they work with workflow

data saved from PRIMER:

· EuroNCAP Front FFB Impact 2017

· EuroNCAP Front MPDB Impact 2020 Occupant Assessment

· EuroNCAP Front ODB Impact 2017

· EuroNCAP Side MDB Impact 2022

· EuroNCAP Side Pole Impact 2022

· CNCAP Front MPDB Impact 2022 Occupant Assessment

Running the templates interactively

As an example of how to use the templates we'll use the EuroNCAP Side Pole Impact 2022

template, but they all follow the same process:

· In PRIMER specify and save the required data using the Automotive Assessments

workflow

· In REPORTER use File→ Open Library Template to select the relevant template.

Templates that use workflow data are indicated by the   icon:

· On opening the template you will be prompted to select the keyword file of the job

you want to post-process

https://help.oasys-software.com/smart/project-reporter/standard-library-templates
https://help.oasys-software.com/smart/project-reporter/standard-library-templates
https://help.oasys-software.com/smart/project-reporter/standard-library-templates
https://help.oasys-software.com/smart/project-reporter/standard-library-templates
https://help.oasys-software.com/smart/project-reporter/standard-library-templates
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
https://help.oasys-software.com/smart/project-reporter/reading-a-library-template
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· After pressing OK a file selector is mapped for you to select the keyword file.

· After selecting the keyword file a prompt will ask if you want to proceed with some

default directories to search for model results and for writing images and other

files. The defaults assume:

1. The results are in the same directory as the keyword file

2. REPORTER will use a subdirectory in the keyword file directory named

"EuroNCAP_Side_Pole_Impact_2022" to write images and other files to (the

name will differ depending on the template). If the directory doesn't exist

REPORTER will create it.

· If you are happy with the defaults press Yes and you can skip the next steps. T/HIS

will start to post-process the results according to the protocol, generating the

required graphs.

· If you want to change the directories press No. This will open PRIMER with a window

where you can select the directories (and the model keyword file if you want to

change this):

· Once selected, press Run. This will close PRIMER and start T/HIS to post-process the

results according to the protocol, generating the required graphs

· Once finished, T/HIS will close and the template will be generated:
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Running the templates in batch

The templates can also be run in batch mode, specifying the required information through

command line arguments.

If your results are in the same directory as the keyword file then you only need to specify

the keyword file on the command line:

<reporter_exe> -batch -file=<template_name> -varKEYWORD_FILE=<keyword_file> -
exit

[Add the -pdf, -html, -pptx command line arguments to write the report out in the format

you want]

Where:

reporter_exe The full path and filename to the REPORTER executable  

template_name

The full path and filename of the template you want to use.

The workflow templates can be found in

$OA_INSTALL/workflows/templates/automotive_assessments

https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
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If the results are in a different folder to the keyword file, you will need to add an extra

argument to specify it:

<reporter_exe> -batch -file=<template_name> -varKEYWORD_FILE=<keyword_file> -
varRESULTS_DIR=<results_dir> -exit

Where:

Similarly if you want to output the images and other files generated by REPORTER to a

different folder than the default, you will need to add an extra argument:

<reporter_exe> -batch -file=<template_name> -varKEYWORD_FILE=<keyword_file> -
varOUTPUT_DIR=<output_dir> -exit

Where:

Reasons for migrating the templates to the

workflow framework

Migrating the standard templates to use data saved from the Automotive Assessment

workflow has the following benefits:

· Setting up the data and generating the templates is simpler with fewer steps

required

· The same data can be used in the Automotive Assessment workflow in T/HIS to

interactively plot and interrogate results

· It makes it easier to add templates for new protocol versions and protocols not

currently supported

reporter_exe The full path and filename to the REPORTER executable  

keyword_file The full path and filename of the keyword file

results_dirThe full path to the results directory

output_dirThe full path to the output directory
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3.2. Energy Check

Energy Check

Tools→Workflows→ Energy Check

The Energy Check Workflow is a quick tool to help plot global energies for your model and

perform checks. 

In PRIMER we can set the tool up, by selecting the model unit system, selecting the desired

time and energy units and selecting the tolerances and percentages allowed for the energy

checks.

In T/HIS, this tool displays the Kinetic Energy, Internal Energy, Hourglass Energy, Total

Energy, Absolute Total Contact Energy, External Work and Total System Energy. Multiple

checks are completed on these energies such as the percentage of Hourglass Energy

compared to Total Energy, the Absolute Total Contact Energy compared to Internal Energy

and Energy Ratio (Total System Energy).

Setup in PRIMER

When this tool is initially launched, PRIMER will ask you to select which model you want to

use to configure for Energy Check. You can only configure a single model at a time.

Model Unit System
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You can select the unit system used for the model from the drop-down menu.

Once you have selected the unit system, the Display Time Unit and Display Energy Unit will

automatically update to match the model unit system.

Display Time Unit

You can select the display time unit to use: Seconds or Milliseconds.

Display Energy Unit

You can select the display energy unit to use: Joules, Millijoules, Kilojoules or Foot-Pounds.

Hourglass Energy Warning

You can change the warning value of which Hourglass Energy as a percentage of Total

Energy will be flagged.

Hourglass Energy should be less than 5% of Total Energy, therefore the default for this

check is 5%.

Contact Energy Warning

You can change the warning value of which absolute Total Contact Energy as a percentage

of Internal Energy will be flagged.

Contact Energy should be less than 5% of Internal Energy, therefore the default for this

check is 5%.

Energy Ratio Tolerance

You can change the warning value of which Energy Ratio (Total Energy minus External Work

or Total System Energy) will be flagged at if the curve has exceeded the tolerance. Total

System Energy should remain constant (Energy Ratio should stay at 1.0), although this is

not realistic therefore the default for this check is 1%.

Saving

Save the Workflow data to a .json file or save it to your model and then write the keyword

file from PRIMER.
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Use in T/HIS

When this tool is initially launched, the tool will complete a first run of the script by

producing the aforementioned energies and checks. Once the run has completed the GUI

will look something like this by default:

Energy Checks

The first check determines if Hourglass Energy is below the percentage you specified of

Total Energy. If this check is a fail, the maximum percentage will be displayed in the GUI.

On its graph, the Hourglass Energy as a percentage of Total Energy is displayed with

datums used to visualise the warning threshold. If Hourglass Energy does not exist in the

model or have the same number of points on the graph as Total Energy, the check will not

be displayed.

The second check determines if absolute Total Contact Energy is below the percentage you

specified of Internal Energy. If this check is a fail, the maximum percentage will be

displayed in the GUI.

On its graph, the Contact Energy as a percentage of Internal Energy is displayed with

datums used to visualise the warning threshold. If time intervals for contacts are not

consistent with other energies, the check will not be displayed. Please edit the DT field for

GLSTAT within the \*DATABASE_ASCII card to enable fill accuracy of this check.

The third check is Energy Ratio, which determines if the Total System Energy (Total Energy

minus External Work) is constant. If this check is a fail, the energy ratio value will be

displayed in the GUI.

On its graph, if TER - total/initial (Energy Ratio) is available as a curve in your model then it

is displayed with datums to visualise the tolerance threshold.
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If it is not available then (Total Energy - External Work) / Initial Total Energy is displayed,

please note this check is calculated manually so may not be as accurate. Please request

GLSTAT in your model to enable full accuracy of this check. If External Work is not available

in your model, the check will not be displayed.

Model Unit System

The unit system that has been selected in PRIMER for this model.

Setup

You have the option to change the Display Time Unit, Display Energy Unit, Hourglass

Energy Warning, Contact Energy Warning and Energy Ratio Tolerance just like in PRIMER,

however any adjustments made here won't be saved upon re-load of the workflow, unlike

in PRIMER if it was saved to a .json or to the model. Press 'Recalculate' to reproduce the

graphs and energies with the updated setup options.

Recalculate

You can recalculate the energies and checks with the any changes made to the display

time/energy units and warning tolerances taken into effect.

Plot Parts with Greatest Total Energy

Plots the Kinetic, Internal, Hourglass and Total Energies of the biggest N parts in the users

model calculated by their greatest Total Energies. N is a value specified by the user, from 1

to 6.
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3.3. Entities of Interest

Entities of Interest

Tools→Workflows→ Entities of Interest

The Entities of Interest tool allows you to visualise specific groups of entities quickly in

D3PLOT and action them. Actions include:

· Only

· Zoom In

· GLB Export

· Mixed-Mode Plot

· Highlight

· Colour By

Setup in PRIMER

In PRIMER, open Entities of Interest from the Workflows menu (Tools→Workflows→

Entities of Interest). In the menu that appears, you can a dd groups of entities to a list,

and save it to a Workflows .json file or add the data to your model in PRIMER and then

write the keyword file.
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Adding Entries to the List

For each group of entities, make sure that you complete the following steps:

1. Name

You must give your entry a name so it can be identitfied

2. Type

Select the entity type for your entry. Current options are Parts, Parts by Set, Parts

by Include or Parts by Group

3. Select...

Select the entities for your entry by using the menu that appears on the right-hand

side.

4. Add

Once you have completed the above steps, Add your entry to the list.

Only and Unblank all
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You can select as many entries from the list as you want and then click Only to show only

the selected entries. You can click Unblank all at any time to unblank the entire model.

Edit

You can only have one entry selected to Edit an entry. Much like adding an entry to the list,

you then update its name and/or the entities in the entry. You can not change entity type.

Delete

Select one or more entries from the list and click Delete to delete them.

Saving

You can either save your list of Entities of Interest to a .json file or directly to the model.

The user data from the file will then be picked up when the Workflow is selected in

D3PLOT.

Use in D3PLOT

When you open Entities of Interest in D3PLOT, your list of entries will be displayed, along

with action buttons:
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Reset

You can Reset the selected models to default.

Only

Select one or more entries and Only them.

Zoom In

Select one or more entries and Zoom In on them.

GLB Export

Select one or more entries and GLB Export them for use in D3PLOT Viewer. This will open

the GLB Export Options window, which has the following options:

· Directory

Provide a valid directory location for saving GLB files
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· Output

Select the output type – either Current Frame or Animation

· Frame Rate

If Animation is chosen for output, select the default Frame Rate

· Export

Once the above options are all valid, click Export to export one GLB file for each of

the selected entries. The exported GLB filenames will correspond to the entry

names.

Mixed-Mode Plot

Select one or more entries and perform aMixed-mode plot on them.

The selected entities will be plotted by a method of the users choice. The default is CT

however you can select from the following options using the dropdown menu:

Continous tone solid contour (CT), colour contours with lightning model (SI), line contour

plot (LC), cloud points plot (CL), Iso-surface contour plot (ISO), velocity arrows plot (VEL) and

interface stresses and forces (INT).

Any entities that are not selected will turn transparent and grey. The transparency can be

set by the user using the transparency textbox, the default is 75%.

Highlight

Select one or more entries and Highlight them.

The highlighted entities will turn opaque and a colour of your choice from the dropdown

menu, the default is red.

The non-highlighted entities will turn grey and transparent of which the value can be set

the user using the transparency textbox, the default is 75%.

Transparency

The Transparency textbox is used to control the transparency value used in Mixed-Mode

Plotting and Highlighting. The default is 75%.

Colour

Select one or more entries and Colour them.

The selected entities will become opaque and turn a colour of your choice from the

dropdown menu, the default is red.
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3.4. Eroded Elements

Eroded Elements

Tools→Workflows→ Eroded Elements 

The Eroded Elements tool allows you to visualise eroded (deleted) elements in your LS-

DYNA simulation.

Note that while using this tool, elements are drawn as they appear at state 1.

Use in D3PLOT

You don't need to set up anything in PRIMER to use the Eroded Elements Workflow. Simply

open it in D3PLOT (Tools→Workflows→ Eroded Elements) to visualise Eroded Elements

for any set of results.

When you open Eroded Elements, the elements deleted in the final state are displayed. The

following menu will appear:

The menu provides several options to control the visualisation of eroded elements.

Plot state

You can choose to display the elements deleted at any plot state. Use the controls in the

menu to change plot state, rather than D3PLOT's main controls. Only elements deleted

between the comparison state and the plot state will be displayed. Note that the plot state

cannot be before the comparison state.

Display mode

There are three display modes:
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1. Eroded elements only (default)

Only the elements deleted between the comparison state and the plot state are

shown (all other elements are blanked)

2. Eroded elements in red

Displays the elements deleted between the comparison state and the plot state in

red and all other elements in transparent-grey.
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3. Parts with eroded elements

Only the parts with elements deleted between the comparison state and the plot

state are shown (all other parts are blanked). Elements on these parts that are not

deleted will be shown in transparent-grey.

 

 

Comparison state

You can choose to display the elements deleted between the comparison state and the

main selected state. The comparison state can be modified via the textbox. Only elements

deleted after the comparison state will be displayed. Note that the comparison state

cannot exceed the plot state.

Properties

When Eroded Elements is opened, a temporary properties file is saved. When you exit the

tool, you can choose to restore the model properties (view, blanking, colours, etc.) to their

appearance before you opened the tool.
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3.5. Intrusion Contour Plot

Intrusion Contour Plot

Tools→Workflows→ Intrusion Contour Plot

The Intrusion Contour Plot tool creates a contour plot of intrusion displacements for

selected parts, relative to specified reference coordinates:

Setup in PRIMER

In PRIMER, open Intrusion Contour Plot from the Workflows menu (Tools→Workflows→

Intrusion Contour Plot). In the menu that appears, select intrusion parts and reference

nodes , and then save the data to a Workflows .json file or add the data to your model in

PRIMER and then write the keyword file:
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Intrusion Parts

Select which parts you wish to include in the intrusion plot. The specified parts will be

unblanked in D3PLOT by default, and the camera will adjust to point at the selected parts.

Reference Nodes

Select three reference nodes that will be used to define a reference coordinate system and

for setting up the camera in D3PLOT. The intrusion contours are calculated relative to this

reference system.

Saving

You can either save the setup data to a .json file or directly to the model. The user data

from the file will then be picked up when the Workflow is selected in D3PLOT.

Use in D3PLOT

When you open Intrusion Contour Plot in D3PLOT, the plot will appear immediately. A

menu will appear giving you further controls:

· Plot State

You can display the intrusion contour plot at any state. Use the controls in the menu

to change plot state, rather than D3PLOT's main controls.

· Reference State

You can adjust the plot to show intrusion relative to a reference state (and, when

using with multiple models, from a specified model rather than from the model

itself).

· Keep View Updated

If the checkbox is ticked then each time a state or reference state change is made,

the camera resets. Uncheck this option if you wish to control the view manually.
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3.6. Pulse Index Tool

Pulse Index

Tools→Workflows→ Pulse Index

During the early stages of vehicle development, it can be useful to understand occupant

acceleration without needing to include a complex and computationally expensive

occupant model.

The Pulse Index Workflow allows you to estimate the acceleration that would be

experienced by a vehicle occupant in a crash test scenario.

The tool assumes a virtual single-degree-of-freedom mass-spring system in which the

occupant is represented by amass and the seatbelt is represented by a spring. See below

for more details of the pulse index calculation.

This virtual mass-spring system is effectively attached to a selected nodemoving with a set

initial velocity.

The tool optionally takes a slack input to account for seatbelt engagement.

How to use the Pulse Index tool in PRIMER

Access the Pulse Index tool from the Workflows menu in PRIMER. Upon selecting the Pulse

Index tool, the following menu will appear:

https://help.oasys-software.com/smart/project-common-topics/pulse-index-tool/a/h3_1574142438
https://help.oasys-software.com/smart/project-common-topics/pulse-index-tool/a/h3_1574142438
https://help.oasys-software.com/smart/project-common-topics/pulse-index-tool/a/h3_1574142438
https://help.oasys-software.com/smart/project-common-topics/pulse-index-tool/a/h3_1574142438
https://help.oasys-software.com/smart/project-common-topics/pulse-index-tool/a/h3_1574142438
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
https://help.oasys-software.com/smart/project-primer/workflows-menu-in-primer
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Units System

Select the appropriate units system for your model. All of the input Parameters will be

expecting an input in the selected units system. When the selected unit system is changed,

all existing inputs are automatically converted to the new units system.

Mass of occupant

Enter a mass (must be a non-zero positive value) for the virtual vehicle occupant. (This

mass will not be added to the model mass and so will not have an effect on the LS-DYNA

results.)

Initial velocity

Enter the initial velocity of the vehicle.

Restraint stiffness
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The Pulse Index can either be calculated with constant or variable restraint stiffness (must

be a non-zero positive value). For Constant stiffness, enter a non-zero stiffness value. For

Variable stiffness, select a *DEFINE_CURVE keyword that defines the variable stiffness in

terms of the model units (you may need to create a new keyword before making the

selection).

Slack (optional)

You can choose to add slack to the seatbelt. This option allows the virtual vehicle occupant

to move freely for a specified distance before the restraint stiffness begins to take effect.

Slack works with both constant and variable stiffness options.

Measurement node

Select a *DATABASE_HISTORY_NODE that will be used as the node on the vehicle structure

to which the virtual single-degree-of-freedom mass-spring system will be attached.

Display Units

Select time (Seconds or Milliseconds) and displacement units (Metres, Millimetres or Feet)

to use on the graphs using the dropdowns. For the acceleration graph use the radio

buttons to calculate in g or the display units. Please note if the Unit System is changed, the

Time and Displacement Units will default to the matching ones for the Unit System, for

example changing to U5 would default the Time units to Seconds and the Displacement

units to Feet.

Save

You can save the Workflow Definition to a .json file or to the model (as post-*END data).

When saving to the model, you will need to write the model from PRIMER in order to save

the changes to the keyword file.

How to use the Pulse Index tool in T/HIS

Access the Pulse Index tool from the Workflows menu in T/HIS. Upon selecting the Pulse

Index tool, the same menu appears as in PRIMER. This allows you to adjust some of the

https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
https://help.oasys-software.com/smart/project-this/workflows-menu-in-this
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input parameters when performing the pulse index calculation. The Measurement Node

and Variable Stiffness settings can only be modified in PRIMER.

Calculate

If the input parameters are valid, the Calculate button will become active. Clicking

Calculate executes the pulse index calculation and produces a four-graph layout

comparing Vehicle and Virtual Occupant results, such as in this example:

Pulse Index Calculation

Initial Conditions

The vehicle and virtual occupant both start with zero initial displacement:

\(s_t^{veh} = s_t^{occ} = 0\)

The vehicle and the virtual occupant are both given the same initial velocity, defined by you

in PRIMER. In PRIMER, you also specify the restraint system stiffness \(k\) and the

measurement node for the vehicle acceleration \(a_t^{veh}\).

Iterative Calculation
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The Pulse Index Workflow performs an iterative calculation to determine the displacement

\(s_t^{occ}\), velocity \(v_t^{occ}\) and acceleration \(a_t^{occ}\) experienced by the virtual

occupant over time. First, the vehicle's velocity \(v_{t+1}^{veh}\) and displacement

\(s_{t+1}^{veh}\) at time \(t+1\) are calculated from its acceleration \(a_t^{veh}\):

\(v_{t+1}^{veh} = v_t^{veh} + a_t^{veh} * dt\)

\(s_{t+1}^{veh} = s_t^{veh} + v_t^{veh} * dt\)

Then the change in displacement \(dx_{eff}\) between the vehicle and virtual occupant is

calculated:

\(dx = s_t^{occ} - s_t^{veh}\)

\(dx_{eff} = (|dx| - slack) \frac{dx}{|dx|}\)

The occupant acceleration is then calculated from the change in displacement, the

occupant's mass \(m\) and the restraint stiffness \(k\):

\(a_t^{occ} = \frac{k}{m}dx_{eff}\)

Finally, the occupant's resultant velocity and displacement are calculated, ready for the

next time iteration:

\(v_{t+1}^{occ} = v_t^{occ} + a_t^{occ} * dt\)

\(s_{t+1}^{occ} = s_t^{occ} + v_t^{occ} * dt\)
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3.7. Seismic

Seismic Workflows

These are a collection of workflows catered to help you interrogate the results of

your seismic analysis and generate automated reports.

Currently, there are two workflows available for generating global structural results:

Storey Drift
Storey Force
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3.7.1. Storey Force

Storey Force

Tools→Workflows→ Storey Force

The Storey Force workflow tool is used to show forces on each storey of the

building to investigate the flow of force through the entire structure or on selected

elements grouped into SET_PARTs.

In PRIMER, you can define cross sections for each SET_PART, for every storey of the

building.
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In T/HIS, storey forces are extracted for each of the cross sections you defined in

PRIMER and then storey curves are generated – plotted on graphs.

This allows you to interrogate the global behaviour of the structure and make

changes to member designs or structural layout if necessary.

Finally, you can generate automated reports with the REPORTER templates

provided.

In the report, corresponding D3PLOT views are paired with each T/HIS plot to

highlight the corresponding SET_PART(s) in the model.
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3.7.1.1. Storey Force REPORTER

Storey Force Report

This workflow provides you with REPORTER templates to automatically generate

report documents. The templates compile all T/HIS graphs you have set in PRIMER

and T/HIS along with a model view from D3PLOT to show you the SET_PART(s) you

have specified on each graph.

There are currently two templates with different report layouts available:

· 1x1 layout showing one T/HIS-graph/D3PLOT-model-view pair per page, split

vertically.

· 2x1 layout showing two T/HIS-graph/D3PLOT-model-view pairs per page.

Running the template

Upon opening the template, you will be prompted to select the parent/root folder

where all your model keyword files sit. If you have followed the recommendations

for Writing the Workflow File from PRIMER, this should be the same directory where

you have saved the Workflow file.

When multiple models are detected, the template will show you another window

where you can choose which models to include in the report. By default, all models

are selected assuming that the root folder only contains the relevant model

analysis runs that you wish to process and report.

https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-force-primer/a/h2_1225591604
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After this, the template generation should commence, running T/HIS and D3PLOT items to

generate the report images. These images will also be saved into a subfolder named

"reporter" that will be created when this template is generated. A sample page from a

successful template run is shown below.

The REPORTER variables hold a record of the paths of models you have chosen to run. This

can serve as a way to validate that you have run the models you intended.
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3.7.1.2. Storey Force T/HIS

Storey Force Viewer

When the tool is launched in T/HIS, the storey force curves will be generated for

each graph setup existing in the Workflow file. Then you will be presented with the

window below.

When the Workflow file is initially created from PRIMER, default graph setups are

included, one for each force component, for each SET_PART defined. The storey

force curves will be created for each of these graph setups and the first graph setup

will be plotted in T/HIS and will be active in the Viewer GUI.
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The Viewer GUI is generally split into four sections listed below:

1. Graph selection/creation panel

2. Curve display settings

3. Storey force limits definition

4. Storey datum settings

Graph selection/creation panel
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This panel allows you to cycle through the graphs you have generated. You can use

the navigation buttons to view the graphs sequentially or you can select a graph

from the drop-down list.

You will be provided with three toggles: SET_PARTs, force components, and

model. The toggle for SET_PARTs will only be shown if more than one SET_PART is

included in the current graph setup. All force component toggles will be shown, but

only those included will be active. Finally, the model toggles will only be visible if

more than one model is loaded in the current T/HIS session.

 

In this panel, you are provided with control buttons allowing you to create or

modify graph setups.

To create a new graph, click Create. You will then be presented with a new window

as shown below. Select the SET_PARTs and force components you wish to include.

Once you have made your selections, the Add to Graph button will be active.

Click Add to Graph to generate the list of curves that will be added to the graph,

which will be shown on the list box on the right. You can then do any final selection

adjustments (e.g. you can remove some of the curves listed by selecting them and

clicking Remove).

Once you have finalised the curves you wish to include, click Create to generate the

new graph and return to the Plot Viewer window.
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Other commands available to you are as follows:

1. Edit – modify the currently active graph setup in your Plot Viewer. You will

be shown a similar window as for Create.

2. Remove – delete the currently active graph setup. This will not delete the

T/HIS curves associated with the graph.

3. Reset – delete every graph setup and recreate the defaults set in PRIMER.

Any modifications made in the graph selection panel will be automatically

saved to the Workflow JSON file.

You may also wish to export the current T/HIS curves to an external file. You can do

this by clicking Export to CSV.

Curve display settings

This panel allows you to define the formatting of the curves in the T/HIS graph.

These settings will be applied to all graph setups stored in your Workflow file. Later

when you generate the report, REPORTER will read these settings and apply the

styling you have defined. 
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The Workflow file will hold two separate sets of settings for single model

mode and multiple model mode. This is because you may want to have different

settings when you are plotting results for only one model and when you are

plotting results for multiple models. If you are intending to generate reports

containing results from a single model and from multiple models, you need to

define the settings for these two modes separately.

The first three settings are responsible for categorising your curves by SET_PART,

force component and model – in the following hierarchy order: 

You can categorise the SET_PARTs and force components by Colour or Line

style. For instance, if you display the SET_PARTs by colour and the force

components by line style, the tool will then assign one colour for all curves under a

SET_PART and will assign one line style for all curves under a force component. As

shown in the example below, all curves under ElementTag:All;GroupTag:All are

red and all the curves representing shear force along the X direction (FX) have

solid lines:
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You can also categorise the models by Colour or Line style. However, there is a

third option called Inherit (which is set by default). This option essentially tells the

tool that the curves will not be categorised by model. Instead, they will just follow

the formatting of the first two categories. This is particularly useful if you are more

concerned with the aggregate curves and you are just displaying the model curves

to see if there is an outlier compared to the aggregate curve. If you use this option,

you can quickly identify visually which model curves are associated with an

aggregate curve.

In the example below, the curves representing the shear forces

(FX) of ElementTag:All;GroupTag:All are solid lines in red colour. The curve

representing the mean storey forces follows the same format but with a thicker line

width to differentiate it from the rest of the individual model curves under the

same categories.
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This current implementation of curve categorisation may not work for all scenarios,

and could be improved in future. Please contact us with any feedback.

The other curve settings available to you are as follows:

1. Show Models – set whether the model curves are shown or hidden in the

plot. This is only relevant formultiple model mode.

2. Summarise by – choose which aggregate curve is shown. You have the

following options: None, Average, Envelope.

3. Model Colours – choose whether the model curves will be in Colour or

Greyscale.

4. Summary Colours – choose whether the aggregate curves will be

in Colour or Greyscale.

5. Model Line width – set the line width for the model curves.

https://oasys-software.com/dyna/contact-us
https://oasys-software.com/dyna/contact-us
https://oasys-software.com/dyna/contact-us
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6. Summary Line width– set the line width for the aggregate curves.

Any modifications made in this settings panel will not be automatically saved to the

Workflow file. Click Save to write these settings to the Workflow file. You can also

revert back to default settings by clicking Reset, which will simultaneously update

these settings in the Workflow file.

Storey Force limits

This panel allows you to define vertical curve limits on the positive and negative X-

axis. One scenario where this feature will be useful is when you are analysing

member design utilisation – for a shear wall segment, for example. You can import

the design capacity of the wall and plot it against the wall forces to illustrate

whether the current wall design is acceptable.

There are two types of vertical storey curve limits that you can define:

1. Constant curve limit along the structure elevation

2. Stepped curve limit, where the desired limit per storey extent varies

You can define a constant curve limit using the panel. In order to define a stepped

limit curve, you need to import an external CSV file. There are no default curve

limits for the Storey Force Workflow. One way to get an example curve limit input



Page 82 of 235

file is to create constant curve limits in the panel and then click the Export button

to write them to a file which will show you how these data are structured.

You can also import a constant curve limit using an external file and this file can

contain multiple curve limits of different types. Theoretically, you can store all your

curve limits in one file to quickly generate them later.

To define a constant curve limit, you need to define a label and the X-axis value in

the textboxes provided. Then, click Add.

To define a stepped curve limit, create a CSV file following the data format of the

exported sample file, as described above. Click Import to add the data to the plot.

The limits created will be listed below along with some control buttons to

manipulate them:

1. Show or hide the curve limit using the ON/OFF toggle button

2. Change the colour of the curve limit using the provided colour selection

drop-down

3. Delete a curve limit using the delete (X) button provided. Currently, this

panel does not allow you to edit an existing curve limit. You may need to

recreate a curve limit to modify the X-value(s) along the storeys.
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The storey curve limits will be automatically saved to the Workflow file upon

creation. Curve colour and visibility settings will also be automatically updated in

the Workflow file. You may wish to store these data separately for future use. You

can do so by clicking Export located on the right side of the panel header.

You can also revert back to default storey curve limits by clicking Reset.

Each Workflow will have a different set of default limits.

Storey datum settings

This panel allows you to define the formatting of the storey datums shown on the

plot. This panel is hidden by default. Click the Show button to expand this panel.

The settings available to you are as follows:
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1. Colour – choose the colour of the storey datums

2. Line Style – choose the line style of the storey datums

3. Line Width – choose the line width of the storey datums

4. Label Font – choose the font of the storey datum labels

5. Label Size – choose the font size of the storey datum labels

6. Label Position – define the location of the labels relative to the storey

datums

Any modifications made in this settings panel will not be automatically saved to the

Workflow file. Click Save to write these settings to the Workflow file. You can also

revert back to the default settings by clicking Reset, which will simultaneously

update these settings in the Workflow file.
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3.7.1.3. Storey Force PRIMER

Storey Force Setup

When the tool is launched in PRIMER, the setup window opens. This where you

select the SET_PARTs and cross-sections you wish to process:

First, you need to choose the appropriate unit system from the dropdown menu:

 

Defining Storey Data

You can define the storey data for the structure either by clicking the Create button

or the Import button under the Setup Storey Data section. Import allows you to

import previously saved storey definitions (e.g. those created for the Storey

Drift workflow). When you click Create, the Storey Data window appears:

https://help.oasys-software.com/smart/project-common-topics/storey-drift
https://help.oasys-software.com/smart/project-common-topics/storey-drift
https://help.oasys-software.com/smart/project-common-topics/storey-drift
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Each storey can be defined manually by populating Name and Elevation textboxes and

then clicking the Add button which will be activated if the inputs are valid.

Alternatively, you can define multiple storeys automatically by clicking Generate. You will

be prompted to select nodes in the model. This will then generate storeys for each unique

elevation (z-coordinate) among the nodes you have selected. Finally, you can then modify

the labels of each generated storey to be more informative for your project.
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Click Apply to import the storey data back to the main setup window.

You can optionally save this data by clicking Save. This will write it to a separate JSON file,

which you can Import when you are starting a new setup. Normally, storey data would be

applicable to multiple Seismic workflows, so saving this data will be useful to those other

workflows too.
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Defining SET_PARTs

If you have not defined any SET_PARTs prior to running this Workflow, you can use

the Create button under the Setup SET_PART(s) section of the setup window. A

popup window will appear allowing you the create a new SET_PART. This window is

the same as PRIMER's usual Create SET_PART menu (Volumes I & II→ SET→

PART→ Create).

If you have defined some SET_PARTs beforehand, you can use them by

clicking Select. A selection window will appear, prompting you to choose

SET_PARTS in the model.
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Some section controls will be active when you select SET_PARTs in the list box as

shown above. You will have access to SET_PART commands that will allow you to

modify a SET_PART or update your list.

1. Modify – modify SET_PARTs one at a time. A popup window will appear to

allow you to modify the properties of the SET_PART and add or remove

PARTs from it.

2. Remove – remove existing SET_PARTs from the list. This will not delete them

from the model.
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3. Delete – remove existing SET_PARTs from the list and delete them from the

model. The deletion is not recursive so the PARTs along with their

components will still remain.

4. Sketch – highlight the contents of one or more SET_PARTs in the model.

5. Only – isolate the components of one or more SET_PARTs in PRIMER,

blanking everything except those components.

6. Reset view – reset the state of the model in view and remove sketches.

7. Refresh – re-validate the SET_PARTs listed. If any SET_PARTs have been

deleted using other PRIMER menus, this command will remove them from

the list too.

Defining Storey DATABASE_CROSS_SECTIONs

DATABASE_CROSS_SECTIONs can be derived from the storey and SET_PART

definitions by clicking Generate. This button will be active only after you specify a

positive offset value. The offset value applies a vertical offset for the cross-sections

from each storey level z-coordinate. The purpose of the offset is to ensure that

DATABASE_CROSS_SECTIONs intersect beam, shell and solid elements, preferably

at their midpoint, rather than aligning with nodes at their ends (which would

typically be the case without an offset, since storey levels are typically defined at

node locations).

A popup window will appear upon successful cross-section generation. It will show

you how many new DATABASE_CROSS_SECTIONs have been created in the model,

and/or how many existing ones have been added to the CROSS_SECTION(s) sub-

section list box.
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Similar to the SET_PARTs, some commands will be available to you when you select

DATABASE_CROSS_SECTIONs in the list box.

1. Remove – remove existing DATABASE_CROSS_SECTIONs from the list. This

will not delete them from the model.

2. Delete – remove existing DATABASE_CROSS_SECTIONs from the list and

delete them from the model.

3. Sketch – highlight the DATABASE_CROSS_SECTIONs you selected, along with

the SET_PARTs they refer to.

4. Reset view – reset the state of the model in view and remove sketches.

5. Refresh – re-validate the DATABASE_CROSS_SECTIONs listed. If any

DATABASE_CROSS_SECTIONs have been deleted via other PRIMER menus,

this command will remove them from the list too.



Page 92 of 235

Tip: You may want to delete an entire set of DATABASE_CROSS_SECTIONs from the

model that were created by previously running this Workflow. To quickly delete

unwanted DATABASE_CROSS_SECTIONs, repopulate the setup window with the

previous storey data and SET_PARTs you have used, and then generate the

CROSS_SECTIONs with the same offset value. Once these CROSS_SECTIONs are

listed, you can select them all and click Delete.

Writing the Workflow File

Once all data has been defined, save the storey force setup by clicking Save. This will write

a Workflow file in JSON format. This file will be used to post-process the defined

DATABASE_CROSS_SECTIONs in T/HIS and create a report in REPORTER.

The Storey Force Workflow tool has been designed to be used on a sweep of LS-DYNA runs

with different ground motions applied to the same model. It is advised to save the

Workflow file in the parent folder (the folder containing several child folders, each

containing one set of ground motion results). Currently, this Workflow will only work

properly if only one Workflow file exists in the parent folder, including its child folders. If

you save this file in the folder of an individual model, then there is a risk to duplicate the

Workflow file, which might cause problems later. This will most probably happen when you

duplicate the original model to create a new model with a different ground motion input.

For this workflow, one DATABASE_CROSS_SECTION will be generated for each

storey, for each SET_PART definition. Remember to save the .key file and rerun the

model if new DATABASE_CROSS_SECTIONs have been created, so their results will

be available in T/HIS.

Before saving the drift setup, you may also wish to select an include file for the

DATABASE_CROSS_SECTION(s). You can choose an include file by
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clicking Select above the DATABASE_CROSS_SECTION(s) header. The tool will add

any DATABASE_CROSS_SECTION keywords created to your selected include file.

Resetting the data

To reset all data, click Clear all and repeat the whole process again to define a new

storey force setup. Alternatively, you can select all items in sections 2 and 3 of the

setup window and click the Remove buttons on each sub-section to remove the

data defined on those sections only.

Importing existing Workflow Data

When an existing Workflow file is present in the root folder, the storey data and

SET_PARTs are automatically imported when you run this Workflow.

After removing all data in a current session, you can import the storey data and the

SET_PARTs by clicking Import on each sub-section. The SET_PARTs stored in the

Workflow file are then validated, and only those existing in the model will be

displayed. For further details on importing storey data, please refer to the following

section of this manual.

Importing existing Storey Data

As mentioned on the section above, you can import pre-defined storey data to

quickly define storeys. The storey data may exist in an external JSON file or in

the Workflow file. If it is present, you will be prompted to use an existing Workflow

file. If you choose not to, then a file selector popup will appear so you can select an

external JSON file.
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3.7.2. Storey Drift

Storey Drift

Tools→Workflows→ Storey Drift

The Storey Drift workflow tool is used to post-process building drifts on various

locations in the structure which can be used to check compliance against relevant

building standards.

In PRIMER, you can setup drift locations, defining nodes for each storey of the

building.
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In T/HIS, storey drifts are calculated for each of the locations you defined in PRIMER

and then storey curves are generated – plotted on graphs.

This allows you to interrogate the global behaviour of the structure and make

changes to member designs or structural layout if necessary.

Finally, you can generate automated reports with the REPORTER templates

provided.
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In the report, corresponding D3PLOT views are paired with each T/HIS plot to

visually locate the drifts in the model.
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3.7.2.1. Storey Drift REPORTER

Storey Drift Report

This workflow provides you with REPORTER templates to automatically generate

report documents. The template compiles all T/HIS graphs you have set in PRIMER

and T/HIS along with a model view from D3PLOT to show you the locations of drifts

you have specified on each graph.

There are currently two templates with different report layouts available.

· 1x1 layout showing one T/HIS-graph/D3PLOT-model-view pair per page, split

vertically.

· 2x1 layout showing two T/HIS-graph/D3PLOT-model-view pairs per page.

Running the template

Upon opening the template, you will be prompted to select the parent/root folder

where all your model keyword files sit. If you have followed the recommendations

for Writing the Workflow File from PRIMER, this should be the same directory where

you have saved the Workflow file.

When multiple models are detected, the template will show you another window

where you can choose which models to include in the report. By default, all models

are selected assuming that the root folder only contains the relevant model

analysis runs that you wish to process and report.

https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
https://help.oasys-software.com/smart/project-common-topics/storey-drift-primer/a/h2_1225591604
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After this, the template generation should commence, running T/HIS and D3PLOT

items to generate the report images. These images will also be saved into a

subfolder named "reporter" that will be created when this template is generated. A

sample page from a successful template run is shown below.

The REPORTER variables hold a record of the paths of models you have chosen to

run. This can serve as a way to validate that you have run the models you intended.
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3.7.2.2. Storey Drift T/HIS

Storey Drift Viewer

When the tool is launched in T/HIS, the storey drift curves will be generated for

each graph setup existing in the Workflow file. Then you will be presented with this

window below.

When the Workflow file is initially created from PRIMER, default graph setups are

included – one for each direction component, for each drift location defined. The

storey drift curves will be created for each of these graph setups and the first graph

setup will be plotted in T/HIS and will be active in the Viewer GUI:
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The Viewer GUI is generally split into four sections listed below:

1. Graph selection/creation panel

2. Curve display settings

3. Storey drift limits definition

4. Storey datum settings

Graph selection/creation panel
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This panel allows you to cycle through the graphs you have generated. You can use

the navigation buttons to view the graphs sequentially or you can select a graph

from the combo box.

You will be provided with three toggles: drift locations, direction components,

andmodel. The toggle for drift locations will only be shown if more than one drift is

included in the current graph setup. All direction component toggles will be shown,

but only those included will be active. Finally, the model toggles will only be visible if

more than one model is loaded in the current T/HIS session.

In this panel, you are provided with control buttons allowing you to create or

modify graph setups.

To create a new graph, click Create. You will then be presented with a new window

as shown below. Select the drifts and direction components you want to include.

Once the selection is made, the Add to Graph button will be active. Click Add to

Graph to generate the list of curves that will be added to the graph, which will be

shown on the list box on the right. You may then do some final selection

adjustments (e.g. you can remove some of the curves listed by selecting them and

clicking Remove).

Once you have finalised the curves you wish to include, click Create to generate the

new graph and return to the Plot Viewer window.
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Other commands available to you are as follows:

1. Edit allows you to modify the currently active graph setup in your Plot

Viewer. You will be shown with a similar window as for Create.

2. Remove allows you to delete the currently active graph setup. This will not

delete the T/HIS curves associated with the graph.

3. Reset deletes every graph setup and recreates the defaults set in PRIMER.

Modifications made in the graph selection panel will be automatically saved

to the Workflow JSON file.

You can also export the current T/HIS curves to an external file. You can do this by

clicking Export to CSV.

Curve display settings

This panel allows you to define the formatting of the curves in the T/HIS graph.

These settings will be applied to all graph setups stored in your Workflow file. Later,

when you generate the report, REPORTER will read these settings and apply the

styling you have defined. 
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The Workflow file will hold two separate sets of settings for single model mode

andmultiple model mode. This is because you may want to have different settings

when you are plotting results for only one model and when you are plotting results

for multiple models. If you are intending to generate reports containing results

from a single model and from multiple models, you need to define the settings for

these two modes separately.

The first three settings are responsible for categorising your curves by drift

location, direction component and model – in the following hierarchy order:

You can categorise the drift locations and direction components by Colour or Line

style. For example, if you display the drift locations by colour and the direction

components by line style, the tool will then assign one colour for all curves under a

drift location and will assign one line style for all curves under a direction

component. As shown in the example below, all curves under Drift SW are red and

all the curves representing drifts along the X direction (DRX) have solid lines:
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You can also categorise the models by Colour or Line style. For models, there is a

third option called Inherit (which is set by default). This option essentially tells the

tool that the curves will not be categorised by model. Instead, they will just follow

the formatting of the first two categories. This is particularly useful if you are more

concerned with the aggregate curves and you are just displaying the model curves

to see if there is an outlier compared to the aggregate curve. If you use this option,

you can quickly identify visually which model curves are associated with an

aggregate curve.

In the example below, the curves under Drift SW along DRX are solid lines in red

colour. The curve representing the mean storey drifts follows the same format but

with a thicker line width to differentiate it from the rest of the individual model

curves under the same categories:
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This current implementation of curve categorisation may not work for all scenarios,

and could be improved further in future. Please contact us with your feedback.

The other curve settings available to you are described below:

1. Show Models allows you to set if the model curves are shown or hidden in

the plot. This is only relevant formultiple model mode.

2. Summarize by allows you to choose which aggregate curve is shown. You

have the following options: None, Average, Envelope.

3. Model Colours allows you to choose if the model curves will be in Colour or

Greyscale.

4. Summary Colours allows you to choose if the aggregate curves will be

in Colour or Greyscale.

5. Model Line width allows you to set the line width for the model curves.

https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
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6. Summary Line width allows you to set the line width for the aggregate

curves.

Any modifications made in this settings panel will not be automatically saved to the

Workflow file. Click Save to write these settings to the Workflow file. You may also

revert back to default settings by clicking Reset, which will simultaneously update

these settings on the Workflow file.

Storey Drift limits

This panel allows you to define vertical curve limits on the positive and negative X-

axis. These limits normally represent acceptable code standard drift limits. They are

typically included in building design reports to demonstrate compliance.

There are two types of vertical storey curve limits that you can define:

1. Constant curve limit along the structure elevation

2. Stepped curve limit, where the desired limit per storey extent varies

You can define a constant curve limit using this panel. In order to define a stepped

curve limit, you need to import a CSV file. You can download an example plot limit

input file by clicking Export defaults.



Page 110 of 235

You can also import a constant curve limit using an external file and this file may

contain multiple curve limits of different types. Theoretically, you can store all your

curve limits into one file to quickly generate them later.

To define a constant curve limit, you would need to define a label and the X-axis

value on the text boxes provided. Then, click Add.

To define a stepped curve limit, create a CSV file following the data format of the

exported default file. Click Import to add the data to the plot.

The limits created will be listed below along with some control buttons to

manipulate them:

1. Show or hide the curve limits using the ON/OFF toggles

2. Change the colour of the curve limits using the colour selection dropdown.

3. Delete a curve limit using the delete (X) button. Currently, this panel does not

allow you to edit an existing curve limit. You may need to recreate a curve

limit to modify the X-value(s) along the storeys.
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The storey curve limits will be automatically saved to the Workflow file upon

creation. Curve colour and visibility settings will also be automatically updated in

the Workflow file upon changing them in this panel. You may wish to store these

data separately for future use. You can do so by clicking Export located on the right

side of the panel header.

You may also revert back to default storey curve limits by clicking the Reset button.

Each Workflow will have a different set of default limits.

Storey datum settings

This panel allows you to define the formatting of the storey datums shown in the

plot. This panel is hidden by default. Click Show to reveal this panel.
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The settings available to you are as follows:

1. Colour allows you to choose the colour of the storey datums

2. Line Style allows you to choose the line style of the storey datums

3. Line Width allows you to choose the line width of the storey datums

4. Label Font allows you to choose the font of the storey datum labels

5. Label Size allows you to choose the font size of the storey datum labels

6. Label Position allows you to define the location of the labels relative to the

storey datums

Any modifications made on this settings panel will not be automatically saved to

the Workflow file. Click Save to write these settings to the Workflow file. You may

also revert back to default settings by clicking Reset, which will simultaneously

update these settings on the Workflow file.
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3.7.2.3. Storey Drift PRIMER

Storey Drift Setup

When the tool is launched in PRIMER, a window appears for you to set up the drift

definitions you wish to process:

First, you need to choose the appropriate unit system from the dropdown menu:

Defining Storey Data

You can define the storey data for the structure either by clicking the Create button

or the Import button under the Setup Storey Data section. Import allows you to
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import previously saved storey definitions (e.g. those created for the Storey Force

workflow). When you click Create, the Storey Data window appears:

Each storey can be defined manually by populating Name and Elevation textboxes

and then clicking the Add button which will be activated if the inputs are valid.

Alternatively, you can define multiple storeys automatically by clicking Generate.

You will be prompted to select nodes in the model. This will then generate storeys

for each unique elevation (z-coordinate) among the nodes you have selected.

Finally, you can then modify the labels of each generated storey to be more

informative for your project.

https://help.oasys-software.com/smart/project-common-topics/storey-force
https://help.oasys-software.com/smart/project-common-topics/storey-force
https://help.oasys-software.com/smart/project-common-topics/storey-force
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Click Apply to import the storey data back to the main setup window.

You can optionally save this data by clicking Save. This will write it to a separate

JSON file, which you can Import when you are starting a new setup. Normally,

storey data would be applicable to multiple Seismic workflows, so saving this data

will be useful to those other workflows too.
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Defining Drift Locations

There are two ways to define drift locations.

1. Create several at once using Add Nodes.

2. Create one at a time by defining the drift label in the column header text box

and then clicking Add Location.

You can define multiple drift nodes at once by clicking Add Nodes. You will then be

prompted to select nodes in the model. It is recommended to select nodes in plan

view to do this quickly:
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The drifts will be assigned with default labels. By right-clicking the drift header, you

can rename the drift with a more informative label, as shown below. You can

click Sketch in this popup menu to locate the drift nodes in the model, helping you

to define an appropriate drift label. You can also redefine new drift nodes for an

existing drift via Select, and even delete a current drift via Delete.
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To add drift locations individually, define the drift label in the column header text

box and click Add Location. A new blank drift column will be added to the table.

You can then add nodes by right-clicking the drift header and then clicking Select.
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You may wish to update specific nodes on each drift manually. To do this, right-click

the desired drift node on the table and use either Pick or Select in the popup

menu.

To delete a node for a particular storey in the drift, just delete the contents of the

cell in the table.
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Writing the Workflow File

Once all data has been defined, save the drift setup by clicking Save. This will write

a Workflow file in JSON format. This file will be used to post-process the defined

drifts in T/HIS and create a report in REPORTER.

The Storey Drift Workflow tool has been designed to be used on a sweep of LS-

DYNA runs with different ground motions applied to the same model. It is advised

to save the Workflow file in the parent folder (the folder containing several child

folders, each containing one set of ground motion results). Currently, this Workflow

will only work properly if only one Workflow file exists in the parent folder,

including its child folders. If you save this file in the folder of an individual model,

then there is a risk to duplicate the Workflow file, which might cause problems

later. This will most probably happen when you duplicate the original model to

create a new model with a different ground motion input.
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Database history output

For this workflow, DATABASE_HISTORY_NODE(s) will be generated for each drift

node. Remember to save the .key file and rerun the model if necessary. As shown

above, some defined nodes will be latent (highlighted in light blue). This means that

the DATABASE_HISTORY_NODE(s) do not exist in the model yet. You would need to

rerun the model so the results will be available in T/HIS.

Before saving the drift setup, you may also wish to select an include file for the

DATABASE_HISTORY_NODE(s). You can choose an include file by clicking

Select above the Setup Drift Nodes header. The tool will add any

DATABASE_HISTORY_NODE keywords created to your selected include file.

Resetting the data

To reset all data, click Clear all and start the whole process again to define a new

drift setup. Alternatively, use Delete All under the Setup Drift Nodes section to

reset only the drift nodes while retaining the storey data.

Importing existing Workflow Data
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When an existing Workflow file is present in the root folder, the storey data and

drift nodes are automatically imported when you run this Workflow.

After removing all data in a current session, you can import the storey data and the

drift nodes by clicking the Import buttons on each sub-section. Storey data must be

imported first before importing the drift nodes. Every node on each drift specified

in the Workflow file are validated. If a node does not exist, it will be highlighted in

the table, flagged as an error. For further details on importing storey data, please

refer to the following section.

Importing existing Storey Data

As mentioned on the section above, you can import pre-defined storey data to

quickly define storeys. The storey data may exist in an external JSON file or in the

Workflow file. If it is present, you will be prompted to use an existing Workflow file.

If you choose not to, then a file selector popup will appear so you can select an

external JSON file.

Dealing with input Errors/Warnings

You might encounter errors or warnings when populating the drift table.
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If errors exists, the Save button will be disabled so you cannot proceed unless the

errors are addressed. On the other hand, warnings will not disable the Save button

so you may still proceed with caution. Make sure the warnings are expected and

intended. For example, drift nodes on one drift location might sit on different XY

coordinates. If the difference is outside the tool's tolerance, this tool will show you a

warning. You may then proceed or update the selection.

Themost critical warnings and errors will be shown at the top of Setup Drift

Nodes section for your information. The cells related to input errors/warnings will

be colour-coded. More details on these is available on the Help button on the right

side of the Setup Drift Nodes section header.
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3.8. Strength Check

Strength Check

Tools→Workflows→ Strength Check

The Strength Check tool allows you to visualise yielding shell, thick shell, and solid parts in

D3PLOT. Note: Yielding parts are parts containing at least one yielding element, measured

as an element with a Yield Utilisation Factor greater than one (or Yield Utilisation

Percentage greater than 100%).

Setup in PRIMER

You don't need to set up anything in PRIMER to use the Strength Check Workflow, but you

do need to make sure that you have generated a ZTF file to accompany your LS-DYNA

results. D3PLOT will read the ZTF file along with the d3plot/PTF files. The ZTF file contains

materials data that D3PLOT needs to determine the yield strength of the parts in your

model.

Use in D3PLOT

Open the Strength Check Workflow in D3PLOT (Tools→Workflows→ Strength Check) to

visualise yielding parts for any set of results with a ZTF file.

https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
https://help.oasys-software.com/smart/project-primer/writing-ztf-and-group-files
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When you open Strength Check, D3PLOT will perform a SI (Shaded Image) plot of the

YUTF: Yield Utilisation Factor component of the model's final plot state with all non-

yielding parts shown in transparent-grey. A menu will appear with further controls:

Plot state

You can display the intrusion contour plot at any state. Use the controls in the menu to

change plot state, rather than D3PLOT's main controls.

Display mode

This tool has three display modes:

1. Non-yielding parts transparent-grey (default)

A CT (Continuous Tone) or SI (Shaded Image) contour plot of the YUTF/YUTP

component of the model with the non-yielding parts displayed as transparent-grey:
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2. Cycle through yielding parts

A CT/SI plot of the YUTF/YUTP component of the specified yielding part. Cycle

through yielding parts using the controls provided.
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3. Plot of entire model

A normal CT/SI plot of the YUTF/YUTP component of the entire model:
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Plot type

Choose between a SI (Shaded Image) contour plot (default) or a CT (Continuous Tone)

contour plot.

Component

Choose to plot either the YUTF: Yield Utilisation Factor data component (default) or the

YUTP: Yield Utilisation Percentage data component.

Contour Levels

There are several options regarding the contour levels:

· Use workflow user-defined contour levels

To better visualise yielding parts, this option is enabled by default. The contour bar

has values from 0.0 to 1.0 (blue to dark orange) in increments of 0.1, and then three

further contour levels in red and magenta, so that all yielding material is clearly

indicated in red/magenta. If this option is unchecked, automatic contour levels will

be used.

https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationfactor
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
https://help.oasys-software.com/smart/project-d3plot/manipulations-of-stress-tensor-components/a/yieldutilisationpercentage
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o Calculate maximum contour value

With the above option enabled then by default, the actual maximum data

value will be calculated for the maximum contour level. For example, if the

maximum yield utilisation factor is 1.263 then the contour levels above 1.0

will be 1.1, 1.2 and 1.263. This makes the maximum yield utilisation clearer.

You can uncheck this option to speed up the plot (skips the maximum value

calculation). In this case, the contour levels above 1.0 will be fixed to 1.1, 1.2

and 1.3.

Examples for different contour level settings

Properties

When Strength Check is opened, a temporary properties file is saved. When you exit the

tool, you can choose to restore the model properties (view, blanking, colours, etc.) to their

appearance before you opened the tool.

Non-user-defined
User-defined without

maximum calculation

User-defined with

maximum calculation

(Default)
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3.9. Virtual Testing

What is Virtual Testing?

Historically, vehicle crashworthiness regulations and NCAP safety ratings have been based

on physical testing alone. This is changing with the advent of virtual testing

crashworthiness protocols. Virtual testing protocols aim to improve overall vehicle safety

by testing the sensitivity of vehicle designs to a wider range of conditions, while minimising

the cost of physical testing.

In virtual testing, a simulation model is validated against a physical test and then – if the

validation is deemed acceptable – variations of the test are rated based on simulation

results called “virtual loadcases”. Initially, these virtual loadcases will consider variations in

impact angle or occupant seating position. In time, they may accommodate the

introduction of human body models to augment the traditional use of anthropomorphic

test devices. Virtual loadcases aim to improve the safety of vehicles in a greater number of

representative real-world scenarios, and for a more diverse range of human physiologies.

Virtual Testing in the Oasys LS-DYNA

Environment

For the last thirty years, the Oasys LS-DYNA Environment has enabled OEMs and their

suppliers to develop vehicle designs that meet legal crashworthiness regulations and

achieve excellent NCAP safety ratings. Automotive CAE has always been about ensuring

that the vehicle performs on test day, so that it can make it to production, and beyond.

Now, automotive CAE is itself part of the test.

We recognise the important role that Oasys LS-DYNA can play, so that you can excel at

Virtual Testing.

Oasys 21.0 W1 (Workflows Update 1)

At Oasys Ltd., we are working on software features to support the upcoming Virtual Testing

protocols. The first protocol to be introduced is the Euro NCAP Virtual Far Side Simulation

& Assessment Protocol, with C-NCAP and others to follow soon.

Oasys 21.0 W1 contains a set of integrated and complementary Workflow tools to power

your Virtual Testing CAE workflows:
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1. Automotive Assessments

The Automotive Assessments Workflow now includes support for the Euro NCAP

Virtual Far Side Protocol, including the injury metrics that feed into Validation

Criterion 2. Automation available via the Euro NCAP Virtual Far Side 2024 VC2

(Assessment Criteria) REPORTER template.

2. LS-DYNA to ISO-MME

A new tool to convert LS-DYNA results into the ISO-MME format as specified by the

Euro NCAP Virtual Far Side Protocol, ready to upload to the VTC Server. The added

REPORTER automation enables you to generate ISO-MME output after each LS-

DYNA job.

3. SimVT

A new, powerful tool for correlating simulation versus test curves, or indeed any

combination of: LS-DYNA models, ISO-MME data, and CSV data. Supports the ISO/TS

18571:2024 rating method and calculates the ISO Scores used in Validation Criterion

1 of the Euro NCAP Virtual Far Side Protocol. Enables detailed analysis of correlation

results, so you can improve the validity of your CAE models. Automation available

via the Euro NCAP Virtual Far Side 2024 VC1 (ISO Scores) REPORTER template.

4. Euro NCAP VTC Quality Criteria

A new, convenient tool for assessing the quality criteria specified in section 6.1 of

the Euro NCAP Virtual Far Side Protocol. The added REPORTER automation enables

you to check the validity of your CAE models after each LS-DYNA job.

5. Euro NCAP VTC Videos

A new, convenient tool for creating the videos specified in section 5.2.1 of the Euro

NCAP Virtual Far Side Protocol. The tool assists with camera positioning and can be

automated to generate videos with your preferred settings.

Further Development

Development does not end with Oasys 21.0 W1. We continue to work on enhancements to

the Virtual Testing Workflows, including:

· Improved usability and automation features

· Support for the Far Side Virtual Testing Protocol published with the C-NCAP

Management Regulation 2024 Edition

· Support for other upcoming protocols

If you are interested in early access to the latest features, or if you would like more

information or a demonstration of Virtual Testing with the Oasys LS-DYNA Environment,

please contact us.

https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
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3.9.1. Euro NCAP VTC Quality Criteria

Tools→Workflows→ Euro NCAP VTC Quality Criteria

The Euro NCAP VTC Quality Criteria workflow tool allows you to perform the quality checks

outlined in Section 6.1 of the Euro NCAP Virtual Far Side Simulation & Assessment Protocol.

How to use the Workflow Tool in PRIMER

When this tool is initially launched, the tool will attempt to collect all previously saved data

from the Automotive Assessments Workflow.

The GUI will look something like this by default:

Model Unit System

Select the unit system of your model.

Display Time Unit

Select the display time unit for the graph outputs, either Seconds or Milliseconds.

Display Energy Unit

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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Select the display energy unit for the graph outputs, either Joules, Millijoules, Kilojoules or

Foot-Pounds.

Display Displacement Unit

Select the display displacement unit for the graph outputs, either Metres, Millimetres or

Feet.

Display Mass Unit

Select the display mass unit for the graph outputs, either Kilograms, Tonnes, Grams or

Slugs.

Dummy Parts

Select the include file containing the WorldSID Dummy by pressing the right arrow for

multiple selection and picking options or manually typing in the textbox.

Head History Node (Global)

Select the DATABASE_HISTORY_NODE matching the Global Head Node of the WorldSID

Dummy by pressing the right arrow for multiple selection and picking options or manually

typing in the textbox. The default is 10123.

H-point History Node

Select the DATABASE_HISTORY_NODE matching the H-point Node of the WorldSID Dummy

by pressing the right arrow for multiple selection and picking options or manually typing in

the textbox. The default is 10501.

B-pillar History Node

Select the DATABASE_HISTORY_NODE matching the B-pillar Node of the Vehicle by pressing

the right arrow for multiple selection and picking options or manually typing in the textbox.

Seat Parts

Select the include file containing the Seat of the model by pressing the right arrow for

multiple selection and picking options or manually typing in the textbox.

Saving
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Save the Workflow data to a .json file or save it to your model and then write the keyword

file from PRIMER.

How to use the Workflow Tool in T/HIS

When this tool is initially launched, the tool will perform the quality checks automatically.

Once the run has completed the GUI will look something like the following image by

default, with 7 checks presented on it's own graph on a single page.

For a full breakdown of each graph and it's results please see 'Understanding Each Graph

and the Results' further down this manual.

Write Results

Writes the results out as displayed in the table in CSV format.

Model Unit System

Displays the unit system that has been selected in PRIMER for this model.

How to use the Workflow Tool in REPORTER

1. Within the Automotive tab in REPORTER, select the Euro NCAP VTC Quality Criteria

template. It can be found by filtering for 'Virtual Testing’.

  



Page 136 of 235

2. Once open you will be prompted to select the LS-DYNA keyword file of the job you

wish to post-process.
 

3. You will then be asked whether you want to continue with the default results and

output directories or configure them in PRIMER.
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4. On the first page an overview of the results will be presented in a table format much

like the GUI output when running the Workflow manually in T/HIS. On the remaining

pages you can see each 'Check' one by one with its results in more detail.
 

Understanding Each Graph and the Results

Full Setup: Maximum Hourglass Energy < 10% of Maximum Internal

Energy

The first graph displays the quality check satisfying the following criteria from part 6.1.2 of

the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

Max. Hourglass Energy of full setup must be < 10% of max. internal energy.

In blue colour, the internal energy of the full setup is displayed (only if the test is a fail).

The datum line is drawn at 10% of the maximum internal energy.

In foreground colour, the hourglass energy of the full setup is displayed.

For this check to pass, the peak of the hourglass energy curve must be within the green

zone.

The limit and result are displayed in the table.
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WSID Dummy: Maximum Hourglass Energy < 10% of Maximum

Internal Energy

The second graph displays the quality check satisfying the following criteria from part 6.1.2

of the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

Max. Hourglass Energy of all WSID components must be < 10% of max. internal energy of

WSID

In blue colour, the internal energy of the WorldSID Dummy is displayed (only if the test is a

fail).

The datum line is drawn at 10% of the maximum internal energy.

In foreground colour, the hourglass energy of the WorldSID Dummy is displayed.

For this check to pass, the peak of the hourglass energy curve must be within the green

zone.

The limit and result are displayed in the table.
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Full Setup: Maximum Added Mass (%) < Total Model Mass at the

Beginning of the Simulation

The third graph displays the quality check satisfying the following criteria from part 6.1.2 of

the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

Max. mass added due to mass scaling to the total model is less than 5 % of the total model

mass at the beginning of the run.

In foreground colour, the percentage mass increase is displayed.

The datum line is drawn at 5%.

For this check to pass, the peak of the percentage mass increase curve must be within the

green zone.

The limit and result are displayed in the table.

 

H-Point Node: Z Displacement (mm) in the First 5ms of the

Simulation

The fourth graph displays the quality check satisfying the following criteria from part 6.1.2

of the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

Less than 10 mm H-point z-displacement recorded in first 5 ms of the simulation (5ms after

t0).

In foreground colour, the Z displacement of the H-Point Node is displayed, zoomed in to

the first 6ms.

The datum line is drawn at 10mm.
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For this check to pass, the peak of the Z displacement curve must be within the green zone

within the first 5ms.

The limit and result are displayed in the table.

 

Full Setup: Maximum Head Y Displacement + 20% < Simulation

Time

The fifth graph displays the quality check satisfying the following criteria from part 6.1.2 of

the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

The simulation time needs to exceed time of maximum head y displacement + 20%

(Equation 1).

The Head Y Displacement is calculated by taking the relative displacement compared to the

B-Pillar Node Y Displacement, plus 80mm for the approximate Head diameter.

In foreground colour, the Head Y Displacement is displayed.

The datum line is drawn at Maximum Head Y Displacement Relative to B-Pillar Node Time +

20%.

For this check to pass, the Head Y Displacement curve should finish in the green zone.

The limit and result are displayed in the table.
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Hourglass Energy Divided by Internal Energy at Maximum Head Y

Displacement

The sixth graph displays the quality check satisfying the following criteria from part 6.1.3 of

the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

Hourglass energy / internal energy at time of max. y head excursion for setup, dummy, sled

and seat.

In foreground colour, the Hourglass divided by Internal Energy of the full setup is

displayed.

In blue colour, the Hourglass divided by Internal Energy of the WorldSID Dummy is

displayed.

In magenta colour, the Hourglass divided by Internal Energy of the Seat is displayed.

In cyan colour, the Hourglass divided by Internal Energy of the Sled is displayed.

In foreground colour, the Maximum Head Y Displacement time is displayed as a square.

There is no pass criteria for this check, it is just calculated and monitored.

The result of each curve at the Maximum Head Y Displacement is displayed in the table.
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Maximum Added Mass

The seventh graph displays the quality check satisfying the following criteria from part 6.1.3

of the EuroNCAP Virtual Far Side Simulation & Assessment Protocol:

Max. added mass (Dummy, seat, sled).

In blue colour, the Added Mass of the WorldSID Dummy is displayed.

In magenta colour, the Added Mass of the Seat is displayed.

In cyan colour, the Added Mass of the Sled is displayed.

There is no pass criteria for this check, it is just calculated and monitored.

The result of each curve at the peak is displayed in the table.
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3.9.2. Euro NCAP VTC Videos

Tools→Workflows→ Euro NCAP VTC Videos

The Euro NCAP VTC Videos workflow tool is part of the Virtual Testing Protocol and allows

users to calculate the views and export the videos outlined in part 5.2.1 of the EuroNCAP

Virtual Far Side Simulation & Assessment Protocol.

The tool attempts to calculate the camera positions automatically based on model entities

you define in PRIMER. You can then adjust and save the views in D3PLOT to be reused to

capture the videos for future LS-DYNA runs.

How to use the Workflow Tool in PRIMER

When this tool is initially launched, the GUI will look something like this by default: 
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Reference ID

Select the Virtual Testing Reference ID from the dropdown, if 'Other' is selected the textbox

below will become active to write your own Reference ID.

Unit System
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Select the Unit System of the model from the dropdown.

*DATABASE_BINARY_D3PLOT_DT

Animations need to be analysed with an output interval of 2ms (0.002s) or less. Changing

the output interval will change the *DATABASE_BINARY_D3PLOT DT keyword field in the

model and thus you will need to save the model and re-run in LS-DYNA to get the updated

output files.

Selections to set up the video views

The following required selections are used to calculate the views. Press the '?' help buttons

in the GUI for a further understanding of each selection.

Dummy Parts

Press the right arrow for multiple selection or picking options or manually type in the

textbox for the Dummy.

Left Outer Sled Part

Press the right arrow for multiple selection or picking options or type the Part ID into the

textbox. It should contain the door frame.

Right Outer Sled Part

Press the right arrow for multiple selection or picking options or type the Part ID into the

textbox. It should contain the door frame.

HEAD0000WSAC Node

Press the right arrow for multiple selection or picking options or type the

*DATABASE_HISTORY_NODE for the Head Node into the textbox. For the WSID Dummy this

is likely to be 10001.

TRRILE03WSAC Node

Press the right arrow for multiple selection or picking options or type the

*DATABASE_HISTORY_NODE for the Left Lower Thorax Rib into the textbox. For the WSID

Dummy this is likely to be 10013.

THRIRI03WSAC Node
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Press the right arrow for multiple selection or picking options or type in the

*DATABASE_HISTORY_NODE for the Right Lower Thorax Rib into the textbox. For the WSID

Dummy this is likely to be 10023.

KNEELEOUWS Beam

Press the right arrow for multiple selection or picking options or type in the

*DATABASE_HISTORY_BEAM for the Left Outboard Knee Load Cell. For the WSID Dummy

this is likely to be 10012.

KNEERIOUWS Beam

Press the right arrow for multiple selection or picking options or type in the

*DATABASE_HISTORY_BEAM for the Right Outboard Knee Load Cell. For the WSID Dummy

this is likely to be 10013.

Fixed Reference Node

Press 'Select...' to Select or Pick a *NODE for the fixed reference node. The purpose of this

is to hold the sled in position during the videos.

Parts to Blank

There might be some parts you wish to blank during all the videos, for example the

windscreen. Press the right arrow for multiple selection or picking options or manually type

the parts in the textbox.

LHD/RHD

Using the Radio buttons, select LHD or RHD for Left Hand Drive or Right Hand Drive

Occupant.

Property Files Save Directory

Select the Directory by pressing on the Directory icon to save the view files (Property (.prp)

and Cut-Section (.cut)).

Saving

Save the Workflow data to a .json file or save it to your model and then write out the

keyword file from PRIMER.
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How to use the Workflow Tool in D3PLOT

When this tool is initially launched, the GUI will look something like this by default:

Step 1: Calculate the Views

Once the Workflow is clicked on, step 1 is to calculate the views.  Use the checkboxes to

control which views you wish to calculate.

When you click Calculate View, properties files are generated and saved in the directory

you defined in PRIMER.

Step 2: Verify & Update the views

Once the views have been calculated, click the “View” buttons to see each view. If you are

not satisfied with the view calculated, you can manually adjust the view by moving the

camera position.

Click the “?” button to remind yourself of what the views should look like according to the

Euro NCAP specification.

Once you are satisfied with the new camera position, click “Update & Save”.
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Step 3: Set the video quality and export
Once you have verified your views, set the start, interval and end time required for your

videos:

· The default start time is set to zero

· The default interval time is set to either 2 or 0.002 dependant on your unit system

as animations need to be analysed with an output interval of 2ms (0.002s) or less

· The end time needs to be set to the time of maximum head excursion x 1.2

Then set the video quality using the slider between 10 and 100. According to the Euro

NCAP specification, the videos should be 1-10 MB in size.

“Export Videos” will export all six videos by default to the directory you defined in PRIMER –

you can change the views to be exported via the dropdown.

How to use the Workflow Tool in REPORTER

1. Within the Automotive tab in REPORTER, select the Euro NCAP VTC Videos template.

It can be found by filtering for 'Virtual Testing’.
 

2. Once open you will be prompted to select the LS-DYNA keyword file of the job you

wish to post-process.
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3. You will then be asked whether you want to continue with the default results and

output directories or configure them in PRIMER.

4. REPORTER will then proceed to generate the report. If there is any missing data,

PRIMER will be launched for you to edit the setup. From then on, REPORTER will

attempt to generate the report with the data it has available.

5. Where videos cannot be produced, a “missing data” image will be displayed.
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6. REPORTER automatically calculates the views and exports the videos. If you have

previously adjusted any of the views, REPORTER will use the saved views. On the

first page of the report, an overview of the results is presented.
 

7. The following pages show each view in more detail. Click "Edit View" to update the

camera positions if you are not satisfied with a specific view.
  

8. Then use the simplified D3PLOT GUI to edit the view.
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3.9.3. LS-DYNA to ISO-MME

Tools→Workflows→ LS-DYNA to ISO-MME

The LS-DYNA to ISO-MME workflow tool is one of the Virtual Testing tools. It helps you

automatically export LS-DYNA results data to ISO-MME format as specified by the Euro

NCAP Virtual Far Side Simulation & Assessment Protocol v1.0, ready for upload to the VTC

Server. Automotive Assessments workflow user data removes the need to manually map

LS-DYNA entities to ISO-MME channel codes.

The LS-DYNA to ISO-MME Workflow involves the following steps:

1. Create Automotive Assessments user data for the "Far Side + VTC" crash test.

2. Complete the LS-DYNA to ISO-MME setup in PRIMER

3. Perform the LS-DYNA to ISO-MME export in T/HIS

4. Optionally, automate the process in REPORTER

Setup in PRIMER

When this tool is initially launched, the GUI will look something like this by default: 

All the inputs are divided in different categories e.g. User data, Contact data, Vehicle

data. Some inputs are already given for reference purposes. e.g. Test name, Laboratory

name, Customer name. You can see what input can be given for each textbox by hovering

over it.
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https://help.oasys-software.com/smart/project-common-topics/ls-dyna-to-iso-mme/a/h1_1274530441
https://help.oasys-software.com/smart/project-common-topics/ls-dyna-to-iso-mme/a/h1_1274530441
https://help.oasys-software.com/smart/project-common-topics/ls-dyna-to-iso-mme/a/h1_1274530441
https://help.oasys-software.com/smart/project-common-topics/ls-dyna-to-iso-mme/a/h1_1274530441
https://help.oasys-software.com/smart/project-common-topics/ls-dyna-to-iso-mme/a/h1_1274530441
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1. Virtual testing ref ID

Select the Virtual Testing Reference ID from the dropdown. If 'Other' is selected, the

textbox below will become active to write your own Reference ID.

2. Test date

If you select "Today", the ISO-MME export will use the current date each time. If you want

to enter the test date manually you can select the other radio button which will enable

manual text entry.

3. ISO-MME format

You can choose between ISO-MME version 1.6 and 2.0. The Euro NCAP Virtual Far

Side Simulation & Assessment Protocol v1.0 specifies version 1.6.

4. Required output channels CSV

This is the list of channels required as per the Euro NCAP Far Side VTC protocol. It will be

loaded automatically. You can modify it or provide your own CSV list, but make sure to

have it in same format. On each line of the CSV file, the first 16 characters need to be the

ISO-MME channel code you wish to output.

5. Get contact information

You can retrieve the contact information required by the Euro NCAP Far Side VTC protocol

automatically from the Automotive Assessments user data. Make sure you have added

valid contact IDs in the Automotive Assessments user data to get it working. You can still

input or modify information manually by editing the textbox values.

6. Calculate distance

PRIMER calculates the distance between the head centre of gravity (CoG) and green, yellow

and orange lines using head node information from Automotive Assessments user data.

We assume the vehicle is symmetric and centred on y = 0 and hence that the orange seat

centreline y-coordinate is symmetrically opposite the occupant's head CoG y-coordinate.

7. Required inputs

Only “Test name” and “Required output channels CSV” are required for exporting channels.

However, note that technically, all inputs are required to conform to the Euro NCAP Far

Side VTC protocol.

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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8. Saving

Save the Workflow data to a .json file or save it to your model and then write out the

keyword file from PRIMER.

LS-DYNA to ISO-MME export in T/HIS

When this tool is initially launched, the GUI will look something like this by default

(provided you have filled all information in PRIMER workflow panel):

1. Modify descriptors

Before performing the export in T/HIS, you can modify any of the descriptors you defined

in PRIMER. 

2. Calculate

Calculate can be used to automatically populate “Solver Information” and “Simulation

Information” from the OTF/d3hsp file and Automotive Assessment user data.

T/HIS will automatically populate the following fields:
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1. Solver Version

2. Solver Precision

3. Platform Name

4. Number of CPUs

5. Time step setting

6. Number of contacts used in the overall simulation setup

7. Number of elements

8. Mass of total setup (used for quality checks)

9. Mass of dummy in kg

10. Mass of seat in kg

11. Mass of sled in kg

12. Mass of centre console in kg

3. Output directory

Select the output directory where you want to export channels in ISO-MME format.

4. Export

Once the output directory is selected, the Export button will be enabled. To perform the

export, the LS-DYNA to ISO-MME workflow tool generates a configuration file from all the

data and runs a separate T/HIS session in batch mode to export ISO-MME channels in the

selected output directory.

Automation in REPORTER

1. Within the Automotive tab in REPORTER, you will be able to select the LS-DYNA to

ISO-MME Template. Filter by 'Virtual Testing' to easily find it.
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2. Once open you will be prompted to select the LS-DYNA keyword file of the job you

wish to post-process.

3. After you have selected your keyword file, you will then be asked if you want to

continue with the default options of REPORTER searching for results in the same

directory of the keyword file and writing images and outputs into a subdirectory

called "lsdyna_to_isomme". If No is selected then PRIMER will be launched and a GUI

will be displayed to configure the options. If Yes is selected the default options will

be used.
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4. T/HIS will then launch automatically to produce the output files for the report.

5. If any of the required inputs are missing or invalid, T/HIS will prompt a message

window (see example below) asking if you would like to create/edit user data. If you

select Yes, PRIMER will be launched and panels will open for you to enter the

required information. If you select No then T/HIS will try to generate the report with

the data available.

6. Once it has completed, T/HIS will close and return back to REPORTER.

7. On the first two pages, summary information is shown in table format much like the

GUI output when running the Workflow manually in T/HIS:

8. On the remaining pages you can see each channel image requested in "Required

output channels CSV". If the input entities were missing or invalid for a given

channel, an empty graph image with a missing or invalid graph title message will be

shown in the report:
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3.9.4. SimVT

What is SimVT?

SimVT is a powerful tool for correlating curves from different data sources: LS-DYNA

models, ISO-MME data and CSV data. SimVT removes the need to run the T/HIS CORA tool

manually, repeatedly. Pairs of curves are matched automatically using tags. Many

correlations can be performed and presented at once.

Why is it called "SimVT"?

The name "SimVT" comes from the fact that its primary purpose is to correlate simulation

versus test data. Additionally, the main motivation for the tool was to provide support for

vehicle manufacturers who need to correlate their simulation crash results against their

physical test results as part of the Euro NCAP Far Side Virtual Testing protocol.

Consequently, SimVT supports the Euro NCAP implementation of the ISO/TS 18571 rating

method used by Euro NCAP's VTC Server.

Over time, SimVT will be enhanced to add support for new Virtual Testing protocols that

are released. If there is a feature or protocol that you would like to see added to SimVT,

please contact us.

https://help.oasys-software.com/smart/project-workflows/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-workflows/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-workflows/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-workflows/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-workflows/cora-correlation-and-analysis-tool
https://vtc.euroncap.com
https://vtc.euroncap.com
https://vtc.euroncap.com
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
https://www.oasys-software.com/dyna/contact-us/
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3.9.4.1. Quick-start Guides

Quick-start Guides

SimVT has been designed to be versatile to support different use cases. To help you get

started, we have provided a number of quick-start guides which should cover the most

common use cases:

1. I have ISO-MME test data from the lab and I want to compare my LS-DYNA

simulation to see how well I perform for the Euro NCAP Virtual Far Side protocol:

Using SimVT for Virtual Testing Protocols

2. I want to conduct a sensitivity study to see how the new simulations I have run

compare against my baseline model: Using SimVT for Sensitivity Studies

3. I have processed simulation results curves myself and I want to compare them

against physical test data: Using SimVT Without LS-DYNA Results
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3.9.4.1.1. Using SimVT for Virtual Testing Protocols

Using SimVT for Virtual Testing Protocols

SimVT has been designed to perform correlation analysis for Virtual Testing protocols.

Initially, only support for the Euro NCAP Virtual Far Side Simulation & Assessment Protocol

v1.0 has been added, but the intention is to add support for other protocols as well.

Euro NCAP Virtual Far Side Protocol Validation

Criterion 1 (ISO Scores)

For this process you will first need Automotive Assessment Workflow data (AAWD) for the

LS-DYNA model you wish to process. You can can follow these instructions to create the

AAWD in PRIMER before proceeding to the steps below in T/HIS. Note that you can create

the AAWD before running a simulation to help ensure that your model will output all of the

required results data for processing according to the Euro NCAP Virtual Far Side protocol.

SimVT can be opened from the Workflows menu in T/HIS provided that you have at least

one LS-DYNA model loaded in to the T/HIS session.

Steps in T/HIS

1. Open T/HIS and read in the LS-DYNA results (e.g. binout000 or .thf files) you wish

to use with the SimVT Workflow.

2. Select Tools→Workflows. Note, if you have “Open Menu Automatically” checked

you can skip this step.

3. Filter for "Virtual Testing" and select SimVT

4. In the Correlation Setup window, click Import ISO-MME or CSV… to select an ISO-

MME index file (the extension should be “.mmi”, “.chn” or “.iso”).

5. Select T1 as the "Reference test" and selectM1 as the simulation (both should be set

to this automatically).

6. In the "Protocol" section of the setup window select Euro NCAP Virtual Far Side

v1.0. This will automatically configure the following settings that are specific to the

protocol:

a. The correlation method will be set to "ISO/TS 18571:2024"

b. The curves will be automatically regularised to10 kHz before correlating

c. The channels list will change to show "protocol channels" rather than

"selectable channels" which makes it easier to identify which channels may

be expected, by the protocol, but are missing from either the simulation or

test data

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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d. Protocol channels that specify the filter class will be automatically derived

from the corresponding unfiltered channel if they are not already defined

e. The "Calculate Head Excursion" button will become active, and can be clicked

to set the maximum evaluation window time to the time of the maximum

head excursion + 20%.

7. Click Calculate Head Excursion to set the maximum evaluation window time to the

time of the maximum head excursion + 20% (provided that the head excursion can

be computed from the selected simulation channels and the analysis curves have a

duration that exceeds the cut off).

8. Inspect the head excursion plot that appears and read the message in the

information window to check that the simulation passes (i.e. ensure that the

simulation has run for long enough). If it fails, you will need to re-run the analysis for

a longer time before repeating these steps.

9. To correlate between simulation and test data, the data must contain matching

pairs of ISO-MME channel codes. Add/remove any channel matching rules that you

require to match T1 channels to M1. Note that test data typically uses filter class "P"

whereas simulation data uses filter class "0" so the filter class equivalence ISO rule

"P|0" is added by default to facilitate matching test data to simulation data.

10. Select the channels you wish to correlate in the channel list (or select all of them by

clicking All). Any channels that are greyed out are missing from the provided

simulation and/or test data.

11. Click Correlate. The setup window will disappear, and it will be replaced by three

windows:

a. Progress window

b. Correlation Table 

c. Plotting Controls

12. Once the progress window has disappeared you can inspect the results in the

Correlation Table and plot the correlation graphs by using the buttons in the table.

13. You can also perform corrective operations to the input curves.

14. Finally, you can export a summary of the results as a CSV file, and save your SimVT

settings for a future session.

Automation in REPORTER

If you save your SimVT settings in step 14 above, you can then use the Euro NCAP Virtual

Far Side 2024 VC1 (ISO Scores) REPORTER template to automate the correlation process

and the ISO Scores calculation for Validation Criterion 1.

https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
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3.9.4.1.2. Using SimVT for Sensitivity Studies

Using SimVT for Sensitivity Studies

Three models are used for this example (but you can use as many as you like):

1. M1 – the baseline model

2. M2 – a variant of the baseline

3. M3 – another variant of the baseline

The purpose of this sensitivity study is to determine if the changes in M2 and M3 compared

to M1 have significantly affected any of the results curves (output channels). Before

following the steps in T/HIS, make sure that each model has Automotive Assessment

Workflow Data (AAWD) defined. You can optionally choose to share the same AAWD for all

the models in the study by placing the AAWD JSON file in a directory that is an ancestor to

all the model results.

Steps in T/HIS

1. Open T/HIS

2. Load the LS-DYNA results for the baseline model

3. Load the LS-DYNA results for one or more models that you want to compare

against the baseline.

4. Click Tools→Workflows. Note, if you have “Open Menu Automatically” checked

you can skip this step.

5. Select SimVT  and select all the modelsM1, M1,M3 etc., 

6. Click on Run (this will open the "Correlation Setup" window)

7. On the Correlation Setup window, select the baseline model (M1) as the "Reference

test".

8. Select all the other models as the simulation(s) (hold down shift when clicking to

select multiple i.e. Shift + M2 +M3).

9. Select the method you want to use for correlating.

10. Add/remove any channel matching rules that you require to match M1 channels to

M2 and M3 etc. (note if you are sharing the same AAWD then the channels will all

match without the need for matching rules)

11. Select the channels you want to correlate in the channel list (or select all of them by

clicking on the All).

12. Click Correlate. The setup window will disappear, and it will be replaced by three

windows:

a. Progress window 

b. Correlation Table 

c. Plotting Controls
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13. Once the progress window has disappeared you can inspect the results on

the Correlation Table and plot the correlation graphs by using the buttons on the

table.

14. You can also perform corrective operations to the input curves.
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3.9.4.1.3. Using SimVT Without LS-DYNA Results

Using SimVT Without LS-DYNA Results

The SimVT tool can can be run directly from the JavaScript menu in T/HIS (Tools→

JavaScript→ SimVT). This is useful if you want to use the tool without loading LS-DYNA

results into T/HIS.

Steps in T/HIS

In this example we will correlate CSV data vs. ISO-MME data to demonstrate using both

types of data.

1. Open T/HIS

2. Select Tools→ JavaScript→ SimVT

3. On the Correlation Setup window click Import ISO-MME or CSV… and select an ISO-

MME index file (the extension should be “.mmi”, “.chn” or “.iso”).

4. On the Correlation Setup window click Import ISO-MME or CSV… and select a CSV

data file.

5. On the Correlation Setup window, select T1 as the "Reference test" and select T2 as

the simulation.

6. Select the method you want to use for correlating.

7. Add/remove any channel matching rules that you require to match T1 channels to

T2.

8. Select the channels you want to correlate in the channel list (or select all of them by

clicking on the All).

9. Click Correlate. The setup window will disappear, and it will be replaced by three

windows:

a. Progress window 

b. Correlation Table 

c. Plotting Controls
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10. Once the progress window has disappeared you can inspect the results on

the Correlation Table and plot the correlation graphs by using the buttons on the

table.

11. You can also perform corrective operations to the input curves.
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3.9.4.2. SimVT Windows
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3.9.4.2.1. Model Mapping Window

Model Mapping Window

The Model Mapping window appears when loading a SimVT settings file from the

Correlation Setup window. It is used to "Map" the model tags defined in the setting file to

the models (or data sources) which are defined in SimVT.

Mapping to Existing Data

In SimVT, existing data sources (i.e. those listed in the model list and imported data list) are

represented by their model tag. For example, LS-DYNA models will be labelled M1, M2 etc.

and ISO-MME and CSV data will be tagged T1, T2 etc. In the model mapping window you

can select existing data sources using the selector arrow at the end of the file path

textboxes. For example, you may have loaded the LS-DYNA models and imported data

source in a different order to the order when the settings file was created. Alternatively,

you may want to change which data source is used as the reference test. In the example

below T2 was the reference test in the settings file, but it has been mapped to T1 which will

become the reference test when Apply is clicked.

Note: You can use the checkboxes under load column to select which models to load, by

default all models are selected for loading.

 

You cannot map the same data source multiple times and the file path textboxes will turn

red to indicate the issue (e.g. M1 and M2 in the settings file cannot both map to the existing

M1 model).

https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
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Mapping to New Data

It is possible to import ISO-MME data and CSV data directly from the model mapping

window. You can paste the path to the data into the file path textbox or you can click on

the file selector and open it from there. In the example below T1 has been remapped to T3

which is a new CSV data source and T2 has been remapped to T4 which is a new ISO-MME

data source. Note that the data for T3 and T4 will not be imported until Apply is clicked.

You can also load new LS-DYNA results into T/HIS from the Model Mapping window. The

LS-DYNA models will not be imported until Apply is clicked. If your model does not

have Automotive Assessments Workflow Data (AAWD) you will need to provide a CSV config

which describes the channel entity-id pairings and select the appropriate unit system and

vehicle drive side. The steps to follow are:

· Choose which of the original model tags (i.e. from the settings file) you want to

remap with new LS-DYNA results.

· Use the file selector to select the LS-DYNA results file (or paste the path into the file

path textbox)
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· Select the unit system [1]

· Select the vehicle drive side [2] (LHD is default)

· Use the file selector to select the CSV config file (or paste the path into the CSV

Config file textbox) [3].
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3.9.4.2.2. Correlation Setup Window

Correlation Setup Window
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The Correlation Setup Window allows you to prepare your desired correlation(s). The

window enables you to:

1. View a list of the available LS-DYNA model(s)

2. Assign a CSV configuration to LS-DYNA models that are missing Automotive

Assessments Workflow Data (AAWD)

3. Import an LS-DYNA model

4. Import ISO-MME data

5. Import CSV data

6. View a list of the imported data

7. Select which model or data source will be used as the reference (this is typically

physical test data from a laboratory)

8. Select which model(s) or data source(s) will be compared against the reference

test (this is typically LS-DYNA simulation data)

9. Select the virtual testing protocol

10. Select the correlation method, the evaluation intervals and calculate head excursion

11. Apply channel matching rules

12. Inspect the available and selectable channels

13. Search for channels using regular expressions

14. Select the channels to be correlated

15. Perform “Simulation(s)” versus “Reference test” correlations on the selected

channels
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1. Model List  

The models that are present in T/HIS when SimVT is loaded will be listed in the Correlation

Setup window. If T/HIS can find Automotive Assessments Workflow Data (AAWD) for a

model, it will appear with "Workflow" and the number of channels that are defined for the

16. Save SimVT settings files

17. Load SimVT settings files
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model next to the model tag (e.g. "M1 (336 channels)"). Alternatively, if T/HIS cannot

find AAWD for a model, only the model tag (e.g. "M2") will be shown. 

2. Assign a CSV configuration  

Creating AAWD for LS-DYNA models is the recommended method for using LS-DYNA model

results with SimVT. However, it is possible to use LS-DYNA results with SimVT without

AAWD, but a CSV configuration file needs to be provided to define the channel mapping

and the model units and vehicle drive side need to be provided in addition. The Assign CSV

config... button will become active when a model which does not have AAWD is selected

from the model list. Click Assign CSV config... to open a window where the CSV config can

be loaded and checked before it is assigned to the selected model. 

3. Import an LS-DYNA Model  

LS-DYNA models can be imported into SimVT for correlating. Click the + button to open a

file selector window. Navigate to your model file and open it to load the data into SimVT. 

4. Import ISO-MME data  

ISO-MME test data (v1.6 and v2.0) can be imported into SimVT for correlating. Click Import

ISO-MME or CSV... to open a file selector window. Navigate to the ".chn" or ".mmi" file in

your ISO-MME data and open it to load the data into SimVT.

5. Import CSV data  

CSV channel data can be imported into SimVT for correlating. Click Import ISO-MME or

CSV... to open a file selector window. Navigate to the ".csv" file with your channel data and

open it to load the data into SimVT.

6. View a list of the imported data  

Imported ISO-MME and CSV data will be displayed in the Imported data list along with the

number of channels defined by the data.
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7. Selecting Reference (test) Source  

The Reference test drop-down can be used to select the reference model or data source.

This is typically physical test data from a laboratory, but an LS-DYNA model can also be

selected (e.g. a baseline model when conducting a sensitivity study). Note that when ISO-

MME or CSV data is imported, the reference test will automatically update to the tag of the

newly imported data (e.g. T1). This is because imported data is expected to be test data so

it is assumed to be the reference data.

8. Select the Simulation(s)  

SimVT supports correlating multiple simulations against reference/test data. The

simulations that are to be compared against the reference test data can be selected using

the Simulation(s) drop-down (hold down Shift to select multiple). Note that the reference

test data cannot be selected.

9. Select the Virtual Testing Protocol  

The Protocol selector allows you to select a protocol so that SimVT will be configured to

meet the protocol requirements.

At present, the Euro NCAP Virtual Far Side v1.0 protocol is supported.  Support for

additional virtual testing protocols will be added in future releases.

When a protocol is selected an information window will appear to explain the protocol

specific configurations that have been applied. 

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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Clicking Calculate Head Excursion  under Method section will attempt* to set the

maximum evaluation interval based on the time of maximum head excursion + 20%

(according to Equation 1 of the Euro NCAP Virtual Far Side v1.0 protocol). Additionally, the

head excursions for the selected simulations will be plotted and a message will also appear

to communicate which simulations passed or failed. Failed simulations should be re-run for

longer so that the end time exceeds the cut-off time of 1.2 times the time of maximum

head excursion.

*In order to compute the head excursion for a selected simulation, the simulation data

source must have the head global Y displacement channel (1?HEAD0000WSDCY0) and the

B-Pillar global Y displacement channel (1?BPILLO0000WSDCY0) defined. It is important that

both channels should represent global Y displacement because using local Y will result in

an incorrect head excursion.



Page 177 of 235

10. Select the Correlation Method  

SimVT supports the same correlation methods that CORA uses. The default correlation

method is ISO/TS 18571:2024, which is consistent with the correlation method employed

by the Euro NCAP Far Side VTC protocol. Other correlation methods can be selected from

the drop-down, or a CORA config file can be used for full control over the correlation

options. This can be created in the T/HIS CORA tool.

Evaluation intervals can also be set in this section by inputting into 'min' and 'max' to set

the values globally or by clicking 'Configure intervals...' to open a window where values can

be set individually for each sim vs test model pair.

11. Channel Matching Rules  

Channel matching rules can be used to help match channels from different data sources

which may differ from the standard ISO-MME naming convention.

12. Inspect the available and selectable channels  

The channel list shows the channels for the selected simulation(s) versus the reference

test. The selected reference test model (T1) is shown in the first column of the associated

model tags. Any selected simulations (M1, M2 and T2) are shown next to it separated by “|”

provided that the channel is present in the simulation data (e.g."T2" is not shown for for

any of the head acceleration channels shown below because it was not defined for the

imported CSV data). Some channels may not be selectable because they are either not

https://help.oasys-software.com/smart/project-this/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-this/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-this/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-this/cora-correlation-and-analysis-tool
https://help.oasys-software.com/smart/project-this/cora-correlation-and-analysis-tool
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defined for (or only defined for) the reference model. They are excluded from the list when

Selectable channels is selected, but shown as greyed out rows when All channels is

selected to indicate that it is not possible to select them for correlating. For example, in the

image below, the filtered head acceleration channels

("11HEAD0000WSACXA", "11HEAD0000WSACYA" and "11HEAD0000WSACZA") are shown as

greyed out rows because the channels are not defined for the reference test (T1) so there

would be nothing to compare the M1 and M2 simulation curves against.

Selecting Selectable channels will update the list to only show channels which are

selectable.

13. Search for channels using regular expressions  
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The channels shown in the the channel list can be filtered using the search box. The search

box uses regular expression matching to determine which channels to show and it is case

insensitive. For example searching for "HEAD.*AC" will filter the list to shown only the head

acceleration curves.

Or searching for "A$" will shown only the channels where the last character is "A" (i.e. ISO-

MME channels that have been filtered with CFC1000).

14. Select the channels to be correlated  

Channels to be correlated can be selected from the channel list using a combination of

Shift+click and Ctrl+click. Clicking on "All" will select all of the channels shown in the list.

Clicking on "None" will deselect all the channels. Selected channels will be highlighted in

blue and the number of selected channels is indicated on the Correlate button. 
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15. Perform “Simulation(s)” versus “Reference test”

correlations on the selected channels  

The Correlate button will become active when 1 or more channels are selected from the

channel list. Click Correlate to commence the correlation.

16. Saving SimVT settings files  

A SimVT settings file (.simvt) can be saved from the correlation setup window by clicking

Save SimVT settings.... The settings file saves all the information required to restore the

session (e.g. data sources, correlation method, selected and plotted channels). Note that

prior to saving a settings file, a channel selection must be made.

17. Loading SimVT settings files  

A SimVT settings file (.simvt) can be loaded from the Correlation Setup window by clicking

Load SimVT settings.... The model mapping window will appear which can be used to

(re)assign models before loading the settings. When the settings are loaded the correlation

will be automatically performed and the Correlation Table window will appear.
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3.9.4.2.3. CSV Configuration Window

CSV Configuration Window

When “Assign config” is clicked on the Correlation Setup window, the CSV Configuration

window will appear. The window enables you to load a CSV configuration file and preview

any warnings or errors with your CSV file data before you actually assign it to an LS-DYNA

model.

Steps to assign a config file:

1. Select an LS-DYNA model from the model list that has no Automotive Assessment

Workflow Data (AAWD) or CSV config data assigned (i.e. only the model tag will be listed

(e.g. "M2"))

2. Click on  “Assign config”, CSV Configuration Window will open.

3. Select the unit system from the drop-down

4. Select the vehicle drive side (LHD is default)

5. Click “Load” and open a CSV file with the correct configuration file format. The

Load button will change to say OK when a config CSV file has been loaded.

6. Check the messages that appear in the window to ensure that the loaded config CSV has

no errors and that it has successfully mapped channel data.

7. If some of the parsing messages require attention click Cancel and update the CSV

before repeating the steps. Note, you can cancel the CSV assignment by clicking Cancel at

any stage.

8. If you happy to proceed with assigning the CSV config, click OK.
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Checking Parsing Messages

When the configuration file is loaded, messages will appear in the window. Each row is

coloured according to the parsing status:

· White means that all the inputs were valid and that the model

contains the entity and ID specified

· Red means there was an error with one or more inputs on the

line

· Grey means that the model did not contain data for the entity type and ID (e.g.,

node 1001 below).

· Orange means that there was something wrong with the line, but it may still be

possible to parse the line.

Messages can be hidden by unchecking the corresponding status inMessage Options to

make it easier to find problematic rows. 

If show CSV line is selected then the messages will show each row of the CSV file.
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If show explanation is selected then the messages will explain the reason for the status.

This is especially useful if there is an error with the CSV data which causes the line to be

skipped. It can also help in identifying where an incorrect entity type or id has been

provided in the config CSV so that it can be corrected before loading in the CSV again.
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3.9.4.2.4. Plotting Controls Window

Plotting Controls Window
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The Plotting Controls Window in SimVT is used to control which graphs appear for the

selected correlation analyses, as well as how those graphs are presented and navigated.

The window is divided into three main sections:

· Virtual Pages [1]

· Graph Options [2]

· Graph Tree [3]

Virtual Pages

T/HIS currently has a limit of 32 graphs per session. Virtual pages are employed to work

around this limitation, allowing SimVT to plot as many graphs as desired. When there is

insufficient space to show the graphs for all the selected channels on the current page,

additional graphs are added to Virtual Pages. The 'Virtual Pages' section in the Plotting

Controls Window allows to navigate through the available virtual pages. The navigation

options are as follows:

· Navigate to first virtual page [1]

· Navigate to previous virtual page [2]

· Navigate to a specific virtual page - requires numerical input [3]

· Navigate to next virtual page [4]

· Navigate to last virtual page [5]

Graph Options

Under the Graph Options section of the Plotting Controls Window the main graph plotting

options are located. These options are described in detail in Graph Options.

Graph Tree
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Under Graph Tree section a list of graph titles grouped by Corridor and Cross Correlation is

presented. The functionality in this section includes:

· Expanding the whole graph tree view [1]

· Collapsing the whole graph tree view [2]

· Expanding an individual section of the graph tree [3]

· Collapsing an individual section of the graph tree [4]

· Highlighting individual graphs as shown below by clicking graph title in the graph

tree view [5]
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3.9.4.2.5. Correlation Table Window

Correlation Table Window

The Correlation Table is used to toggle plotting of the correlations that have been

performed. It also shows the results of all the correlations or “ERROR” if there was an error

when performing the correlation and “NONE” is some of the input data is missing. The

Correlation Table and Plotting Controls are the main way of interacting with the graphs and

results. 

· Back - clicking this button goes back to showing the Correlation Setup Window

· Auto plot - When auto plot is selected any selections made in the table are

automatically (and immediately) plotted. Pending operations are carried out when a

selected channel is plotted too.

· Re-plot - clicking this button to refreshes the plotting. It switches to saying Plot

when Auto-plot is off and is used to update the plotting to match the new selection.
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o the pop-up arrow next to Re-plot opens the graph options pop-up. Note,

changing graph options also triggers a re-plot.

· Export - Clicking this button will open the file explorer so that a CSV file containing

the results for all the channels shown in the table can be exported to the desired

location.

o The pop-up arrow next to Export reveals the option to export the results to

CSV (this is the same as clicking Export directly) and also the option to save a

SimVT settings file.

· Operations - clicking this button (or the expander arrow to the right of it) expands

the operations that can be applied to correct curves if they need to be scaled, offset,

inverted or filtered.

· Ratings -  clicking this button (or the expander arrow to the right of it) expands the

ratings section to give detailed view of the individual correlation ratings for each

channel.

Toggling (selecting) plots

Each row of the Correlation table represents one (simulation versus test) correlation. The

rows of the table are determined by the channels that were selected in the Correlation

Setup window.

Selected channels appear as buttons in the Channel column of the Correlation Table. The

Model column lists the simulation model tag(s) which are associated with the

corresponding channel in the Channel column. Note that it is possible to have multiple

simulations associated with the same channel. If this is the case, the channel button will

occupy multiple rows. For example, in the image below the channel buttons each span 2

rows in the table below because 2 simulation models (M1 and M2) were selected for

correlating versus the same test data.

https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
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Channels with the same object and location strings are grouped together so that all the

channels with the same location and object can be plotted by toggling on the

corresponding button (which may span many rows) in the Location or Object columns

(e.g. object "11" which represents the front left occupant in the vehicle.

Any of the buttons in the Object, Location, Channel andModel columns of the

Correlation Table can be clicked to toggle plots on and off. Clicking an un-toggled (grey)

button in one these columns will automatically toggle all the buttons to the right of the

button that was clicked. If the button in theModel column is toggled then the correlation

plot(s) for that simulation model versus the selected test will be plotted for the channel

defined for the row. Conversely, clicking a button that is already toggled (blue) in any of

these columns automatically untoggles all the buttons to the right of the button that was

clicked which will cause the corresponding plots to be 'unplotted'. Note that by

default, only the corridor graph is plotted for each correlation, but the graph options can

be used to show the cross-correlation plots instead or as well.

Clicking a button in a column and then holding down shift and clicking another button in

the same column will change the selection of all the in-between buttons to match the first

one clicked.

Clicking one of the ratings under Weighted, Total, Corridor and Cross Correlation columns

highlights the plot if it is already plotted.
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3.9.4.3. SimVT Features
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3.9.4.3.1. Ratings and Weightings

Ratings and Weightings

SimVT provides the flexibility to calculate ratings using different methods available in the

rating method dropdown in the Correlation Setup Window. The resulting rating scores are

color-coded differently depending on the protocol that is selected in the protocol

dropdown in the Correlation Setup Window. It’s important to note that when you select a

protocol, SimVT automatically applies the corresponding rating method associated with

that protocol. However, this default selection can be overridden if you wish to use a

different rating method. This ensures that while protocols streamline the rating process,

you still have the control to adjust the methodology as needed.

Individual Ratings

By default, the individual Corridor and Cross Correlation ratings are minimised to reduce

the amount of space the Correlation Table occupies, but they can be shown by clicking the

Ratings expander [1].The total rating is the weighted sum of the Corridor and all Cross

Correlation ratings, with the weights depending on your selected correlation method. The

ratings scores are coloured differently depending on the selected protocol.

For Euro NCAP Virtual Far Side v1.0:

· [0.50, 1.00] - green

· [0.00, 0.50) - red

For anything else:

· [0.94, 1.00] - green
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· [0.80, 0.94) - yellow

· [0.58, 0.80) - orange

· [0.00, 0.58) - red

Weighted Ratings

For all sensor locations where more than one axis is measured, weighting factors wware

calculated for each axis based on the maximum amplitude of the axis, according to

Equation 2 in Section 6.3.3 of the Euro NCAP VTC Simulation and Assessment Protocol v1.0:

\(w_i = \frac{max(|Channel_{test_i}|)}{max(|Channel_{test_x}|) + max(|Channel_{test_y}|)

+ max(|Channel_{test_z}|)}\)   with   \(i = X, Y, Z\)

The weighting factors are presented in [3] and used to summarise the individual ISO scores

for each axis wwof one sensor to one score per sensor wsensor  according to Equation 3 in Section

6.3.4 of the Euro NCAP VTC Simulation and Assessment Protocol v1.0: 

\(S_{Sensor} = \displaystyle\sum_{i} w_i * S_i\)   with   \(i = X, Y, Z\)

For channels without X, Y, Z siblings, the weighted rating is equal to the total rating. To find

out how a single weighted rating was calculated hover over the weighted rating score [2]

or Export Results.
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3.9.4.3.2. Graph Options

Graph Options

OR

 

The graph options controls can be found under the Graph Options section of the Plotting

Controls Window or in the Plot button dropdown of the Correlation Table Window. You can

specify any combination of the following options, all of which are enabled on the view

below:

· Plot corridor graph - controls if the corridor graph is plotted (Note: one of the

graphs must be plotted).

· Plot cross correlation graph - controls if the cross correlation graph is plotted

(Note: one of the graphs must be plotted).

· Add time bounds - controls if vertical lines (dashed red) representing the

evaluation interval are displayed on the graph.

· Add scores to graph title - controls if the rating score is added to the title of the

graph (Note: this only applies to corridor graphs).

· Show legend - controls if a legend is displayed on the graph.

· Add scores to legend - controls if the rating scores are written onto the legend of

the graph.
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· Add method to legend - controls if the rating method is written onto the legend of

the graph.

· Change layout - controls the graph layout of the T/HIS session.
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3.9.4.3.3. Operations

Operations

Corrective operations can be applied to both the simulation and test curves before the

correlation is performed. When running with a Protocol option, operations, including

filtering, are automatically applied according to the protocol and will not appear in the

Operations table. The Operations table is available for performing additional operations,

such as correcting for differences in sign or units, allowing you to fine-tune the process as

needed.

Applying Operations

Operations are accessed by clicking Operations [1] in the Correlation Table Window which

will expanding the window to show the operations that have been applied. This view

is minimised by default to reduce the amount of space that the Correlation Table Window

occupies.

Operations can be applied to both simulation [2] and reference [3] curves.

The order of application is in the order below: (i.e., from left to right)

· MULY scales the Y coordinates by the value entered (default = 1, no scaling). For

example, if you want to invert the sign of a curve, enter “-1”.

· ADDY offsets the Y coordinates by the value entered (default = 0, no offset).

· MULX scales the X coordinates by the value input (default = 1, no scaling).

· ADDX offsets the X coordinates by the value input (default = 0, no offset)

· FILTER applies a CFC filter: CFC1000, CFC600, CFC180, CFC60 are supported (default

= Unfiltered. Note that the filter operation is in addition any filtering that may

already have been applied. For example, in the image above, 11NECKLO00WSFOYB

has 'B' filter class which indicates that CFC600 filtering has already been applied. No

additional filter operations have been applied so they show "Unfiltered" as the

default.)

When you change the value of an operation, the textbox will change to a latent colour to

indicate that the operation is “pending”:
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Pending operations are only executed on channels (rows) that are selected channels.

When Auto plot is active [1] and a channel is selected [2], operations are executed

automatically. Note that the latent coloured textboxes change back to white to indicate

that the operations have been applied and ratings will be recomputed.

Applying Multiple Operations (Auto plot off)

If you plan on applying lots of operations, turn Auto plot off and apply a batch at a time.

When multiple rows are selected, and Auto plot off, you can choose to input a value on

any row and it will be propagated to all the active rows (e.g., the input “123” [1] is applied to

all the active rows in the ADDY column). Pending operations are again shown as with a

latent colour background. Pressing Plot [2] will execute pending operations but only for

channels (rows) that are selected.

When no rows are selected all operation inputs become active, and you can input

operations on a row-by-row basis, but note that pressing Plot will not result in the

operations being applied, you need to select them first.

Regularisation
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After applying the MULX scaling, the curve is regularised to an X axis interval of 0.0001,

which corresponds to a sampling frequency of 10kHz. This is consistent with the Euro NCAP

Far Side VTC requirement to sample curves are 10kHz. Note that the regularisation

happens after corrective scaling of the X axis since curves are assumed to be in SI units

(i.e. time in seconds) and if MULX is used to scale a curve it is assumed to be converting the

time seconds.

Filtering Operations

Care must be taken when using the filtering operations as filtering a channel curve which

has already been filtered will result in different curve and therefore different results

compared to filtering the unfiltered channel curve. In most cases the difference is small,

but if you wish to be consistent with the Euro NCAP Far Side VTC protocol then you need to

make sure that you do not apply another filter to channel curves which have already been

filtered (i.e. their filter class in A, B, C, D etc.).

Saving Operations

Operations are saved in the SimVT settings file and they will be restored when loading

SimVT settings. This can save a lot of time if you plan on reusing the operations you have

defined.

https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
https://help.oasys-software.com/smart/project-workflows/settings-file
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3.9.4.3.4. Channel Matching Rules

Channel Matching Rules

Channel Matching Rules can be defined on the Correlation Setup Window. Creating

matching rules facilitates correlating channels that do not have exactly matching channel

names.

There are two categories of rules that can be created:

1. ISO – allows you to apply rules to specific parts of the ISO-MME channel code

2. General – applies rules to the entire channel string

ISO and General rules can coexist. ISO rules will be applied to everything that qualifies as

ISO-MME channel code and General rules will be applied to the rest.

Matching is enabled through two types of matching rules:

1. Ignore rule – allows you to ignore a part of a string, e.g. the main location (this rule

is only applicable in ISO mode)

2. Equivalence rule – allows you to establish equivalency between two or more

substrings (options).

a. options are separated by the "|" e.g. <option1>|<option2>|<option3>|…

b. there is no limit on the number of options

c. options are case insensitive (e.g. "LE|RI" is equivalent to "le|ri")

d. for ISO rules each option must have the same number of characters as the

selected subject (e.g. Fine Location 1 has 2 characters so all the options that

are treated as equivalent must be 2 characters long).

e. for General rules options do not need to have the same number of

characters as each other.

Adding an ISO rule

· Select an ISO subject by clicking [1] and picking from [2].

· Type a rule in [3]:

o For the ignore rule enter "?"

o For the equivalence rule type in <option1>|<option2>|<option3>|…

· Click Add [4]. If the rule is successfully validated it will appear in the list [5].

Alternatively, use the checkboxes [6] to add or delete any of the following rules with a

single click:

· Ignore test object

· Ignore position

· Ignore filter class
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Note: you can add multiple rules for the same ISO subject.

Examples

To match channels 13HEAD000000ACX0 with 11HEAD000000ACX0:

· Add an equivalence rule by typing in 1|3 and selecting Position as the subject.

· Or add an ignore rule by typing in ? and selecting Position.

Similarly, to match 13HEAD000000ACX0 with 13ABRI000000ACXP:

· Add an equivalence rule by typing in HEAD|ABRI and selectingMain Location as

the subject.

· And add another equivalence rule by typing 0|P and selecting Filter Class.

 

Adding a General Rule
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To add a General rule, follow a similar process, but not that only equivalence rules are

supported.

·

· Select the General subject by clicking [1] and picking [2]. 

· Enter a rule in [3] in the format: <option1>|<option2>|<option3>…

· Press Add [4]. If the rule is successfully validated it will appear in the list [5].

Note: you can add multiple General subject rules.

Examples

To match channels Driver_Airbag with Passenger_Airbag:

· Add an equivalence rule by selecting General in Mode and typing in

DRIVER|PASSENGER. (Note: matching is case insensitive)

Similarly, to match channels Accel_X_Pillar_A with Accel_X_Pillar_B:

· Add an equivalence rule by selecting General in Mode and typing in

PILLAR_A|PILLAR_B. (Note: matching is case insensitive)
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Deleting Rules

Rules can be deleted by selecting one or more from the list [1] and then clicking Del [2] to

delete them from the list.

Important note

Matching rules are only applied when comparing simulation curves with the reference

curves. If you are comparing multiple simulations against test simultaneously, the multiple

simulation channels must match each other exactly. The rules allow them to differ from the

reference only.
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3.9.4.3.5. SimVT Settings File

Settings File

SimVT settings files are a new way for you to load and save your correlation settings from a

particular SimVT session. You can load [1] and save [2] SimVT settings file from the

Correlation Setup Window. A SimVT settings file can also be saved from the Correlation

Table Window by going to Export...→ Save SimVT settings... [3]. The settings file will have

a .simvt extension and will contain the following data:

· Model data

· Channels selected for correlation in the channels list

· Operations associated with selected channels

· Channel matching rules

· Protocol (if selected)

· Rating method settings

· Graph layout settings

· Correlations toggled (pale blue) in the Correlation Table window

Once a settings file is loaded, the Model Mapping Window appears. It is populated with the

saved models, allowing to map those to existing models or new model data.

 

OR
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3.9.4.3.6. Exporting Results

Exporting Results

SimVT allows you to export your correlation results from to a CSV file. To export results,

select Export..→ Export results to csv from the Correlation Table Window and save in a

desired location. The following fields will be written: 

· RUN_ID - Analysis run identifier

· METHOD - Correlation method

· TMIN - Evaluation interval minimum (seconds)

· TMAX - Evaluation interval maximum (seconds)

· MAX_CC_VALUE - Maximum cross correlation value K, K ranges from -1 to 1

· CC_OFFSET_AT_MAX - Time offset at maximum cross correlation value

· CORRELATION_RATING - correlation rating

· PROGRESSION_RATING - correlation rating (specific to CORAplus4.0.4 method)

· PHASE_RATING - phase rating (specific to CORAplus4.0.4 method)

· SIZE_RATING - size rating (specific to CORAplus4.0.4 method)

· SLOPE_RATING - slope rating (specific to ISO18571 methods)

· PHASE_RATING - phase rating (specific to ISO18571 methods)

· MAGNITUDE_RATING - magnitude rating (specific to ISO18571 methods)

· CORRIDOR_RATING - corridor rating 

· TOTAL_SIGNAL_RATING - total signal rating i.e. a combination of corridor and

correlation ratings

· ISO_RATING_MEANING - a classification for the total rating according to the

ISO18571 standard (specific to ISO18571 methods)

· MAX_AMPLITUDE - maximum amplitude of the correlation signal

· WEIGHT - weight calculated based on maximum amplitude

· WEIGHTED_SIGNAL_RATING - weighted signal rating
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3.9.4.4. SimVT FAQ

SimVT FAQ

How can I change the layout of the graphs?

By default the layout is set to 3x3, but you can change the layout from either the using

graph options which can be accessed from both the Correlation Table window and the

Plotting Controls window.

How can I invert the sign of my simulation or test curve so

that they are consistent?

You can invert the sign of either curve using the "MULY" operation. Assuming the curves

are in the same units you simply need to enter "-1" in the "MULY" column for the curve that

needs corrected.

Why are the operations I have entered not being applied?

Operations that have not been applied yet will show with a turquoise background. They are

only applied when the row is selected and plotted. In "Auto plot" mode, selecting a row is

equivalent to plotting it so to force pending operations to be applied you simply need to

select the row by pressing one of the object/location/channel/model buttons that

corresponds to the row in question. When not in "Auto plot" mode you need to press the

Plot button to plot the selected row(s) and force the pending operations to be applied. 

Why do the ratings say "NONE"?

The ratings will say none when it was not possible to perform the correlation. The main

reason for this is that one or both of the curves do not lie within the min and max time

window (a.k.a. evaluation interval) or there is a time offset between them such that they do

not have points in the same X range. You should check the values of the "ADDX" and

"MULY" operations to see if they could explain why the curves do not overlap.
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3.9.4.5. Data Sources

Data Sources

SimVT offers flexibility by supporting channel data from a range of different data sources:

· LS-DYNA with Automotive Assessment Workflow Data

· LS-DYNA with CSV Config File

· CSV Data

· ISO-MME Data
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3.9.4.5.1. LS-DYNA with Automotive Assessment Workflow Data

LS-DYNA with Automotive Assessment

Workflow Data

When you run SimVT from the workflow window you have the option of selecting which LS-

DYNA models you would like to load into the tool. For each selected model ("M1" and "M2"

in the image below), SimVT will attempt to find the associated Automotive Assessments

workflow data (AAWD) because it requires this data to extract labelled channels from the

model. The AAWD also contains additional meta-data such as model units, crash test

protocol, and the vehicle drive side, which is used by SimVT to convert curves to SI units

and to determine the protocol channels.

If SimVT successfully finds the AAWD for a model, it will appear in the model list along with

the number of channels that are available for correlating (e.g. "M1" below). If the AAWD

cannot be found, only the model tag will appear in the model list and you will have the

option to assign channel labels using the CSV Config file (e.g. "M2" below).

Note that the model tags for all the LS-DYNA models that are present in the T/HIS session

will be visible in the model list (even if you did not select them from the workflow window

before launching SimVT). 

https://help.oasys-software.com/smart/project-primer/workflow-tools
https://help.oasys-software.com/smart/project-primer/workflow-tools
https://help.oasys-software.com/smart/project-primer/workflow-tools
https://help.oasys-software.com/smart/project-primer/workflow-tools
https://help.oasys-software.com/smart/project-primer/workflow-tools
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Creating Automotive Assessments Workflow Data

(AAWD)

Follow the steps here to create Automotive Assessments workflow data (AAWD) for an LS-

DYNA model. Note that it is possible to reuse the same workflow data for multiple models

provided that the entity-id mappings and additional meta data (e.g. unit system, crash test

protocol, occupants and vehicle drive side) are the same for each model.
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3.9.4.5.2. LS-DYNA with CSV Config File

LS-DYNA with CSV Config File

LS-DYNA models without associated Automotive Assessment Workflow Data (AAWD) can

still be used with SimVT, but a CSV Config File is required to assign channel labels to the

entities in the model. Note that it is recommended to use AAWD but the CSV Config

File Format is provided for scenarios which AAWD does not support e.g. custom

channel names.

CSV Config File Format

· An example CSV configuration file format showing a mixture of the supported

inputs is shown below.

· The header row is required, but the order of the columns can vary.

· The configuration file supports ISO-MME format channel codes.

· If you are not working with ISO-MME data, you can provide any name you like in the

channel column.

Assigning CSV Config File

When "Assign config" is clicked on the Correlation Setup window, the CSV Configuration

window will appear. Follow these steps to assign a CSV config file.
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3.9.4.5.3. CSV Data

CSV Data

CSV channel data can be imported into SimVT. Once in SimVT it is handled in the same way

as other data sources, allowing you to correlate curves with matching channel names.

CSV Data file format

The CSV file format is based on the CSV format that can be exported from T/HIS using the

CSV X,Y,Y,Y,Y,Y write option.

· The first header row is required and contains the names of the channels that will

be imported

· The first column contains the time values (X points) and the Y value at the time is

given in the adjacent columns. Note that if the Y value is empty or not a number the

row will be skipped

· The word "Time" must appear in one of the cells in the first column. It marks

the end of the header rows (i.e. the row below should contain time-value data)

· The "Time" row can optionally be used to defined the units of the non-ISO-MME

channels. 

· The "Object" and "Location" header rows are optional and are used to group non-

ISO-MME channels in the SimVT Correlation Table.

ISO-MME CSV Channel Data Example

The table below shows some example CSV channel data with ISO-MME channels defined.

Note that:

· The first cell (A1) is empty.

· The first row contains valid 16 character ISO-MME channel codes for each column.

· The first column contains the word "Time" in the second row and the data values

begin on the row below.

· The second row has no unit data defined as the units can be determined from the

ISO-MME channel codes' physical dimension (e.g. AC is acceleration so will have

units of m/s^2)  
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Non-ISO-MME CSV Channel Data Example

The table below shows some example CSV channel data with non-ISO-MME channels

defined. Note that:

· The first cell (A1) contains the word "Channel" - this is optional when the channel

names are on the first row.

· The channel names are not valid ISO-MME channel codes so they will not benefit

from the ISO-MME channel matching for each column.

· The first column contains the word "Time" (i.e. "Time | Units") in the fourth row and

the data values begin on the row below.

· The "Time" row also has unit data defined as the units cannot be determined from

non-ISO-MME channel codes. 

· The "Object" and "Location" rows are defined, so the channels will be grouped

together on the SimVT Correlation table.
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3.9.4.5.4. ISO-MME Data

ISO-MME Data

ISO-MME data is supported (versions 1.6 and 2.0 are supported). All the channels (curves)

defined in the index file will automatically be extracted and labelled (tagged) with their ISO

channel codes. ISO-MME data will typically be test data obtained from a physical crash test,

but the tool will work with ISO-MME data that has been generated from simulation results,

for example, by using the LS-DYNA to ISO-MME workflow tool.

Instructions for importing ISO-MME data in SimVT can be found in this LS-DYNA with ISO-

MME Example.

Click on the   button on the Correlation Setup window

IMPORTANT: ISO-MME data is assumed to be in SI units. Some test houses provide angular

results in degrees rather than in radians. Please check your ISO-MME test data before

importing it to ensure that angles are in radians. This applies to rotations, angular velocities

and angular accelerations.
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3.9.5. Euro NCAP Virtual Far Side VC1 (ISO Scores)

Euro NCAP Virtual Far Side VC1 (ISO Scores)

This topic focuses on the automation of the Validation Criterion 1 (ISO Scores) assessment

using REPORTER. You can also use SimVT to perform the correlation interactively.

Introduction

The Euro NCAP Virtual Far Side 2024 VC1 (ISO Scores) REPORTER Template can be used

to perform the Validation Criterion 1 (ISO Scores) check according to section 6.3.5 of the

Euro NCAP VTC Simulation and Assessment Protocol v1.0:

Validation Criterion 1 (ISO Scores): \(S_{Sensor} > 0.5\)

If the template is successfully generated it will show a report summarising the the sensor

scores for all the mandatory and monitored channels (listed in Table 6 of the protocol) as

well as the correlation graphs for each channel so that you can inspect any channels which

perform poorly. Additionally, a SimVT settings file (REPORTER_settings.simvt) is created which

can be loaded in to the SimVT workflow tool to interrogate the results interactively.

Before using the REPORTER template (either interactively or in batch), you should have

defined the occupant and structures user data required for your model in PRIMER (see

Automotive Assessments PRIMER for details).

Running the template interactively

In REPORTER, click the Automotive tab and then filter by Virtual Testing (under protection)

and double-click Euro NCAP Virtual Far Side 2024 VC1 (ISO Scores) to open the template.

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf


Page 218 of 235

T/HIS will launch straight away and an input window will appear:

You can optionally select a previously-saved SimVT settings file (*.simvt) using the file

explorer icon on the first row. This can be useful to define any channel matching rules and

corrective operations you require. If the SimVT settings file is valid it will automatically

populate the "Simulation" and "Test" file path rows.

If you select a SimVT settings file then you can optionally change the "Simulation" and

"Test" file paths to point to data sources that differ from those in the SimVT settings

file. For example, you may have a SimVT settings file which defines the channel matching

rules and corrective operations to correlate LS_DYNA_SIM_1.d3thdt vs. ISO_MME_TEST.chn,

but you want to correlate LS_DYNA_SIM_2.d3thdt vs. ISO_MME_TEST.chn so you could load

the SimVT settings file in (which would populate the "Simulation" row
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with LS_DYNA_SIM_1.d3thdt and the "Test" row with ISO_MME_TEST.chn) then change the

"Simulation" path to LS_DYNA_SIM_2.d3thdt so that it will be used instead. 

If you do not select a SimVT settings file then you must input the file paths to the

"Simulation" and "Test" data sources (e.g. files ending with d3thdt, .thf, binout0000, .csv,

.chn, .mmi, .iso).

Next, you need to input the "Output directory" which is where the results will be saved.

Once you are happy with your inputs, click Run.

REPORTER Results

Page 1 contains a summary of the results for all the assessed and monitored channels. It

shows the PASS/FAIL status of Validation Criterion 1 as well as the run duration PASS/FAIL

status that requires the simulation time to be greater than 1.2 times the time of maximum

head excursion.

Page 2 shows the trace of simulation head excursion versus time. The trace must extend in

to the green zone in order for the check to pass. 
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Pages 3-25 show the corridor plots for each sensor. 3D sensors will have X, Y and Z plots:

1D Sensors will have a single plot:
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Monitored sensors are shown with the PASS/FAIL status in parenthesis (e.g. "(PASS)" in the

image above means that the seatbelt B3 force sensor passed the check, but the Euro NCAP

protocol only requires it for monitoring purposes at the moment).

The final pages of the report contain a table showing the detailed results for each

correlation so that they can all be viewed in one place.
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Missing Data

If all the channel data required to calculate a given Sensor Score is found, then that Sensor

Score will be displayed on the summary table (page 1) and the cell will be coloured to

indicate the PASS/FAIL status. Monitored sensors are shown in lighter colours as their

status does not impact the overall Validation Criterion 1 PASS/FAIL status. If channel data

required to perform a correlation is missing then the corresponding results will be shown

as "Missing". The different cell colours and their corresponding status are shown in the

table below.

If any of the mandatory sensors fail to pass Validation Criterion 1 then the overall result will

be FAIL. Otherwise the overall result will be a PASS (regardless of the status on monitored

sensors) unless any of the mandatory sensors have missing data, in which case

the Validation Criterion 1 result will show "Missing". Below is an example results table

showing all the possible statuses.

Colour Status

Mandatory sensor failed

Monitored sensor failed

Mandatory sensor passed

Monitored sensor passed

Missing data to calculate sensor score
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Running the template in Batch

The template can also be run in batch mode, specifying the required information through

command line arguments.

If you want to use the simulation and test data specified by the SimVT settings file then you

only need to specify the output directory and SimVT settings file file on the command line:

<reporter_exe> -batch -file=<template_name> -varOUTPUT_DIR=<output_directory> -

varSIMVT_SETTINGS_FILE=<simvt_settings_file> -exit

[Add the -pdf, -html, -pptx command line arguments to write the report out in the format

you want]

Where:

reporter_exe The full path and filename to the REPORTER executable  

template_nam

e

The full path to the EuroNCAP_Virtual_Far_Side_2024_VC1_ISO_Scores.ort

template:

$OA_WORKFLOW/templates/simvt/EuroNCAP_Virtual_Far_Side_2024_VC1_ISO

_Scores.ort

Note that $OA_WORKFLOW should be substituted with the full path to

your workflows 21.0 W1 directory. Note $OA_WORKFLOW is set using

the workflow_definitions_directory preference 

https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
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If you want to override the simulation and test data specified by the SimVT settings file

then you only need to specify the extra arguments, varSIMULATION_DATA_PATH and

varTEST_DATA_PATH respectively:

<reporter_exe> -batch -file=<template_name> -varOUTPUT_DIR=<output_directory> -

varSIMVT_SETTINGS_FILE=<simvt_settings_file> -

varSIMULATION_DATA_PATH=<simulation_file> -varTEST_DATA_PATH=<test_file> -exit

Where:

If you do not want to use a SimVT settings file you can remove -varSIMVT_SETTINGS_FILE

provided that both varSIMULATION_DATA_PATH and varTEST_DATA_PATH are defined:

<reporter_exe> -batch -file=<template_name> -varOUTPUT_DIR=<output_directory> -

varSIMULATION_DATA_PATH=<simulation_file> -varTEST_DATA_PATH=<test_file> -exit

reporter_exe The full path and filename to the REPORTER executable  

output_direct

ory

The directory where the correlation graphs images, results.csv and

REPORTER_settings.simvt are written to (it must exist and you must have

write permissions).

settings_file

The full path and filename of the SimVT settings file. The SimVT settings

file argument is optional, but if it is provided it will be used to configure the

channel matching rules, corrective operations and correlation method* used.

*Note that the Euro NCAP protocol mandates that the default ISO/TS

18571:2024 protocol is used for correlations.

simulation_file

The full path and filename of the simulation data source. This is optional if -

varSIMVT_SETTINGS_FILE is defined, but it can be used to override the

simulation data source specified in the SimVT settings file.

test_file

The full path and filename of the test data source. This is optional if -

varSIMVT_SETTINGS_FILE is defined, but it can be used to override the

simulation data source specified in the SimVT settings file.
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3.9.6. Euro NCAP Virtual Far Side VC2 (Assessment

Criteria)

Euro NCAP Virtual Far Side VC2 (Assessment

Criteria)

This topic focuses on the automation of the Validation Criterion 2 (Assessment Criteria)

assessment using REPORTER. You can also use Automotive Assessments to perform the

correlation interactively.

Introduction

The Euro NCAP Virtual Far Side 2024 VC2 (Assessment Criteria) REPORTER Template can

be used to perform the Validation Criterion 2 (Assessment Criteria) check according to

section 6.3.10 of the Euro NCAP VTC Simulation and Assessment Protocol v1.0:

Validation Criterion 2 (Assessment Criteria): \(d_{AC} < 30\%\)

If the template is successfully generated it will show a report summarising the assessment

criterion limits, values, \(r_{AC_{sim}}\), \(r_{AC_{test}}\) and \(d_{AC}\) as well as Far Side

scores. The graphs for all the assessment data and structures are plotted to allow you to

understand the results in more detail.

Firstly, in PRIMER, you should have set up the occupant and structures required for your

Simulation model. This can be found in Workflows in the tools menu, then Automotive

Assessments and under the Crash Test dropdown find 'Far Side + VTC' and fill out the

Driver and Structures (Airbag is optional). Then save the created Workflows data using the

Save to File or Save to Model buttons. For more information see the 'Automotive

Assessments PRIMER' manual.

Using the REPORTER template

Before using the REPORTER template, you should have defined the occupant and

structures user data required for your model in PRIMER (see Automotive Assessments

PRIMER for details).

In REPORTER, click the Automotive tab and then filter by Virtual Testing (under protection)

& Euro NCAP (under regulation) and double-click Euro NCAP Virtual Far Side 2024 VC2

(Assessment Criteria) to open the template.

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
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You will first be prompted to select your Test file, this can be .iso, .mme, .chn or .csv format:

 

Next you will be prompted for the distance between the Head CoG and the Red Line which

marks the inboard intrusion from your previous Side MDB or Side Pole simulation.
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Finally you will be prompted for the Simulation (.key) file. Once selected the REPORTER

Template will run and produce the results.

REPORTER Results

Page 1 contains the DRIVER_HEAD_EXCURSION, and all the required assessment data

(Values, Far Side Scores, Assessment Criteria Limits, \(r_{AC_{sim}}\), \(r_{AC_{test}}\) and

\(d_{AC}\) values). The total Validation Criterion 2 pass or fail is then displayed next to the

Far Side Assessment Criteria scores out of 12.
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Page 2 contains more in depth results for the Simulation Model and Page 3 contains the

same set of results for the Test Model.

Pages 4 to 10 display the graphs for the required assessment data and pages 11 to 24

display the structure data from Table 6 in the Euro NCAP VTC protocol.
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Running in Batch

The template can also be run in batch mode, specifying the required information through

command line arguments.

If your results are in the same directory as the keyword file then you only need to specify

the keyword file on the command line and the test file and red zone which are specific to

this template:

<reporter_exe> -batch -file=<template_name> -varKEYWORD_FILE=<keyword_file> -
varTEST_FILE=<test_file> -varRED_ZONE=<red_zone> -exit

[Add the -pdf, -html, -pptx command line arguments to write the report out in the format

you want]

Where:

reporter_exe The full path and filename to the REPORTER executable  

template_name

The full path and filename of the template you want to use. The workflow

templates can be found

in $OA_INSTALL/workflows/templates/automotive_assessments

keyword_file The full path and filename of the keyword file

test_file The full path to the ISO-MME or CSV file to be used for the Test model

https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
https://help.oasys-software.com/smart/project-reporter/command-line-arguments
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If the results are in a different folder to the keyword file, you will need to add an extra

argument to specify it:

<reporter_exe> -batch -file=<template_name> -varKEYWORD_FILE=<keyword_file> -
varTEST_FILE=<test_file> -varRED_ZONE=<red_zone> -
varRESULTS_DIR=<results_dir> -exit

Where:

Similarly if you want to output the images and other files generated by REPORTER to a

different folder than the default, you will need to add an extra argument:

<reporter_exe> -batch -file=<template_name> -varKEYWORD_FILE=<keyword_file> -
varTEST_FILE=<test_file> -varRED_ZONE=<red_zone> -
varOUTPUT_DIR=<output_dir> -exit

Where:

reporter_exe The full path and filename to the REPORTER executable  

red_zone Distance between the Head CoG and the Red Line

results_dirThe full path to the results directory

output_dirThe full path to the output directory
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4. Changelog
This section was imported from CHANGELOG.zip.

This section contains:

· Oasys 21.0 W1 (Workflows Update 1)



Page 232 of 235

4.1. Oasys 21.0 W1 (Workflows Update 1)

Oasys 21.0 W1 (Workflows Update 1)

This section lists all the changes made to Virtual TestingWorkflows since the Oasys 21.0

release.

Automotive Assessments

Enhancements

1. All the Structure channels which take PARTs as input in the Far Side + VTC crash test

now have a single entity selection textbox. This means you only have to select entity

IDs once for such channels and eliminates the need to perform the same repetitive

selection multiple times.

2. Graphs for failed occupant assessments (e.g. missing channel data) are now

displayed with a helpful title explaining that there was no output for that particular

assessment.

3. Structure assessments can now be plotted for imported data (e.g. ISO-MME or CSV).

The structures are derived from ISO-MME channel data (by matching channel codes

to Structure names).

4. When clicking EDIT for a entity textbox that contains a list of parts, the Edit window

will appear for each part successively after clicking Yes on a window that asks if you

want to keep editing (previously only the first part was shown).

5. Removed restriction of suppliers to just the supported list: ATD-MODELS,

DYNAmore, Humanetics, LSTC, PDB. Users can now define their own custom

supplier name.

6. Added a new Euro NCAP Virtual Far Side VC2 (Assessment Criteria) REPORTER

template for Validation Criterion 2.

7. Added Head Excursion assessment type for Far Side + VTC crash test.

8. Added support for the Validation Criterion 2 ratio calculation and included the

results in the T/HIS results table.

Bug fixes

1. Made Clutch pedal an optional input for Automotive Assessment REPORTER

templates. You are no longer prompted for missing Clutch Pedal input data.

2. Fixed an issue where selecting an entity with a comma in the title would be

incorrectly considered invalid as commas were assumed to only be in part lists.
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3. Fixed an issue where Occupant assessment graphs with no curves were deleted

which meant that all subsequent assessments failed as they referenced a non-

existent graph ID.

4. Fixed an issue where CSV data could not be imported.

5. In PRIMER, if an entity textbox contained a heading (or database history title) string

that started with a number, the corresponding entity ID was incorrectly taken as the

leading number characters which would lead to the incorrect entity being

edited/sketched or a "does not exist" warning. Now fixed.

6. Fixed an issue where a capping limit asterisk was incorrectly being appended to the

Euro NCAP MDB Shoulder Lateral Force assessment score when the limit had not

been exceeded.

Euro NCAP VTC Quality Criteria

Enhancements

1. Results generation is now significantly faster.

2. Entity selection improved to match Automotive Assessment methods and allows

DATABASE_HISTORY headings as well as IDs.

3. The PRIMER GUI is now automatically pre-populated with any data found from

Automotive Assessments.

4. For 10% Max Internal vs Hourglass curves, the Internal Energy curve is removed

from the graph (if test is a pass) so that the critical Hourglass Energy curve is shown

in more detail.

Euro NCAP VTC Videos

Enhancements

1. Entity selection improved to match Automotive Assessment methods and allows

DATABASE_HISTORY headings as well as IDs.

2. The PRIMER GUI is now automatically pre-populated with any data found from

Automotive Assessments.

3. The three Shift Deform reference nodes have been changed to one Fixed reference

node.

4. An Output Interval option has been added in PRIMER that sets the

*DATABASE_BINARY_D3PLOT DT field to ensure output interval is 2 ms or less.

5. Added simulation start, interval and end time options to give more control over

video export.

6. File size visibility added to the REPORTER Template so you don't have to search

through your file system to check.
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7. Euro NCAP Cut Section view now uses true thickness rather than fixed fixness.

8. New option added in PRIMER to allow you to blank parts such as the windscreen

during video export.

Bug fixes

1. The Cut Section view is now normal to the x-axis.

LS-DYNA to ISO-MME

Enhancements

1. When writing out user data, the default Required output channel csv path is now

written out using $OA_WORKFLOW to make the user data more portable across

different machines.

SimVT

Enhancements

1. The new, recently published ISO/TS 18571:2024 method replaces ISO/TS 18571:Euro

NCAP v1.0.

2. The Correlation Setup window layout has been changed to landscape with a larger,

clearer and more informative Channels Table.

3. Evaluation intervals can be controlled individually for each Sim vs Test model pair.

4. A Weight column has been added to Correlation Table window.

5. Channel selection from search improved. e.g. search for HEAD, select all, search for

LUSP, select all.

6. Reverse button added to channel selection.

7. Evaluation interval from Head Excursion calculation is automatically applied to

relevant Sim vs Test model pair.

8. Added support for multiple channel matching rules for same subject.

9. Added a derived channels counter to model hover text.

10. Updated the Protocol explainer text.

11. Improved the Channel Table update time.

12. Added ability to load new LS-DYNA models in to T/HIS from SimVT

13. Added functionality that enables SimVT to check if a new LS-DYNA model has

associated Automotive Assessments Workflow Data (AAWD) and to assign AAWD to

the new model.

14. Added checkboxes to the Model Mapping window so that only the selected rows will

be loaded from the SimVT settings file.



Page 235 of 235

15. Added labels to the Model Mapping window to make it clearer which entries

correspond to "Reference (test)" and "Simulation(s)".

16. The Protocol option now defaults to "Euro NCAP Virtual Far Side v1.0" when SimVT is

loaded as most users are expected to use SimVT for the Euro NCAP Far Side

Validation Criterion 1 check.

Bug fixes

1. The "Save SimVT settings" button is now disabled when no channels are selected,

removing the possibility of saving invalid SimVT settings files.

2. Fixed an issue where Protocol change did not update model tag channels counter.

3. Fixed an issue where evaluation intervals saved to a SimVT settings file were not

validated during reload.

4. Fixed an issue where ISO-MME or CSV data file was interpreted as an LS-DYNA

model path if it was in the same directory as an existing Model in T/HIS.

5. The number of channels shown in brackets after the "LS-DYNA model" and

"Imported Data" sources was not updated correctly when the Protocol option was

selected. This has been fixed and more information is shown in data source hover

text too.

T/HIS CORA

Enhancements

1. The new, recently published ISO/TS 18571:2024 method replaces ISO/TS 18571:Euro

NCAP v1.0.

2. Updated the T/HIS CORA tutorial to reflect the latest changes.

Bug fixes

1. Fixed an issue where CSV export would omit some column titles.
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